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Chapter 1: Getting Acquainted

Front View

# Description

1 Control Panel Touchscreen - Displays the menu and information about the printer 
status. Controls printer functions and settings.

2 Top Cover - Provides access to the print engine, printhead, and service station.

3 ON/OFF LED Button - Turn the power ON or OFF during idle time and 
maintenance.

4 Control Panel USB Port - Use a USB thumb drive to back up print jobs in the 
printer Job Library and debug logs. Upload print jobs from other sources and the 
same model printers. Upload MP4 videos and apply printer firmware (*.fbf) and 
touchscreen UI (*.rpz) files.

5 Clamshell - Holds the upper section of the print engine including the printhead and 
the service station. Lifts to clear the media path.

6 Ink Vapor Exhaust Fan - Draws ink vapor out of the print area and away from the 
exit sensor.

7 Cutter Assembly - Cuts media after each piece or at the end of a job.

8 Fixed and Adjustable Exit Media Guides - Loosen and tighten the knob to slide 
the adjustable exit guide to accommodate different media widths and keep the 
media aligned as it exits the printer.

9 Ink Tank Door - Provides access to ink tanks. When open, disconnects the printer 
communication to ink tanks and allows safe installation and replacement.
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Rear View

10 Ink Tanks - The printer has five ink tanks: cyan, yellow, magenta, and two black.

11 Ink Waste Tray - Catches any waste ink produced by the system. The tray is filled 
with absorbent material. Pull on the tab to remove the tray.

12 Ink Tank Latches - Used to hold ink tanks in the slots.

Make sure both sides at the bottom part of the latch are engaged.

13 Adjustable Media Guide - Adjusts to hold media against the media and alignment 
guides.

14 Clamshell Latch - Release to raise the printhead assembly.

# Description

# Description

1 Top Cover - Provides access to the print engine, printhead, and service station.

2 ON/OFF LED Button - Turn power ON or OFF during idle time and maintenance.

3 Clamshell - Holds the upper section of the print engine including the printhead and 
service station. Lifts to clear the media path.

4 Control Panel Touchscreen - Displays menu and information about the printer 
status. Controls printer functions and settings.

5 Ink Tank Door - Provides access to ink tanks. When open, a switch disconnects 
printer communication to the ink tanks and allows safe ink tank installation and 
replacement.

6 Adjustable Media Guide - Adjusts to hold media against the stationary media and 
alignment guides.

7 Fixed Media Guide - Keeps media aligned as it enters the printer.
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8 Top Forwarding Wheels Assembly and Forwarding Rollers - Moves media 
smoothly into the Printer.

9 Adjustable Media (Entry) Sensor Assembly - Aligns the media sensor to 
accurately read irregular-shaped media (such as die-cut ovals or circles).

10 Network Port - Ethernet cable plugs in here.

11 USB Port - USB cable attaches to the printer here.

12 Interface Port - Connect an external device.

13 Unwinder Interface Port - Unwinder interface cable plugs in here.

14 Main Power Switch, Receptacle, and Fuse - Plug in the power cord here. The 
switch turns the main power ON/OFF. Use the control panel LED power switch to 
turn off the machine for cleaning and maintenance. The fuse protects the printer's 
electronic circuits.

# Description
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Print Engine View

# Description

1 Printhead Latch - When closed, connects the ink revolver couplings with the 
printhead cartridge. When opened, retracts the ink couplings from the printhead 
cartridge and provides access to the printhead cartridge for cleaning and 
replacement.

Warning: Never attempt to open the printhead latch manually. Severe damage will 
result. Use the printhead release in the touchscreen Service drop-down menu 
when no ink is in the system. Use System Deprime when ink is in the system.

2 Ink Revolver Couplings - Connect ink hoses to the printhead cartridge. The 
printhead latch extends and retracts couplings from the printhead.

3 Printhead Cartridge - Printhead produces an 8.5" wide full-color print area.

4 Service Station - Cleans the printhead cartridge of excess ink and debris, keeps 
the printhead hydrated and protected when not in use, captures and removes ink 
used to keep nozzles clear, and moves out of the way of the printhead during 
printing.

5 Service Station Inspection Motor - Moves the service station in and out from 
under the printhead assembly for inspection, cleaning, or service.

6 Printhead Assembly Lifter Motor - Lifts and lowers the printhead assembly over 
the service station for service station access and printing.
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Print Area View (Under Clamshell)

# Description

1 Forwarding Rollers - Move media into the printer.

2 Clamshell “Open” Switch - Signals to the printer when the top assembly latch is 
released and the top assembly is opened. Shows on the touchscreen display and in 
the toolbox system status icon.

3 Adjustable Media (Entry) Sensor - Aligns the media sensor to accurately read 
irregular-shaped media (such as die-cut ovals or circles).

4 Print Platen - Flat surface helps the media transport smoothly through the print 
area.

5 Clamshell Latch - Release to raise Top Assembly to clear media jams or for 
cleaning and other maintenance.

6 Transport Rollers - Keep media moving through the print area.

7 Ink Drip Cover and Tray - Located under the printhead. Catches any excess ink 
coming from the service station and printhead.

8 Encoder Assembly and Guard.

9 Support Strut - Supports the top assembly when raised.

10 Media (Exit) Sensor - Signals to the printer that media has exited the printer.

11 Ink Vapor Exhaust Fans - Draws ink vapor out of the print area and away from the 
exit sensor.

12 Exit Starwheel Assembly - Helps media exit smoothly from the printer.
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Ink Tank Door View

# Description

1 Print Engine Assembly Latch - Release to raise the printhead assembly to clear 
media jams or for other maintenance.

2 Ink Tank Latches - Used to hold ink tanks in slots.

Note: Make sure both sides at the bottom part of the latch are engaged.

3 Ink Tanks - Printer has 5 ink tanks: cyan, yellow, magenta, and two black.

4 Ink Waste Tray - Catches any waste ink produced by the system. The tray is filled 
with absorbent material. Pull on the tab to remove the tray.

5 Ink Tank Disconnect Switch - When the ink door is opened, the switch shuts 
down communication between the printer and ink tanks for safe removal and 
replacement.
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U1C-L Unwinder/Roll Feeder (Optional)

# Description

1 Speed Control - Turn clockwise to speed up, counterclockwise to slow down.

2 AUTO/Manual Mode Switch - Use to set unwinder in automatic or manual mode.

3 Fuse - Unwinder fuse is located here.

4 Hub Assembly - Reversible to fit 1-1/2” and 3” cores.

5 Spindle Lock - Holds the label roll on the spindle.

6 Label Roll Spindle - Holds the label roll.

7 Label Tension Guide Shaft - Spring-loaded shaft controls starting and stopping as 
tension is maintained or released by the media.

8 24V, 2.5A External Power Connector* - For connecting printers or equipment 
other than the QL-900 printer.

Note: External power supply must be a UL Listed power supply.

*Requires disconnecting a wire from the unwinder circuit board and connecting the 
wire from the external power connector.

9 Unwinder Interconnect Cord - Connects the feeder/unwinder to the printer.
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W1C-L Winder (Optional)

# Description

1 Speed Control - Turn clockwise to speed up, counterclockwise to slow down.

2 ON/OFF Switch - Use to turn the winder power ON or OFF.

3 Fuse - Winder fuse is located here.

4 Hub Assembly/Guide - Fits 3” cores.

5 Spindle Lock/Guide - Holds the label roll in place on the spindle.

6 Label Roll Spindle - Used to wind printed labels around an empty core.

7 Label Tension Arm - Spring-loaded shaft controls starting and stopping as tension 
is maintained or released by the media.

8 Adjustable Media Guide Ring - Slides to fit the width of media exiting printer.

9 Tension Control Selector - Increases or decreases the spring tension on the label 
tension arm to accommodate different media widths.

10 24V, 2.5A External Power Connector - For connecting the winder to the AC 
Adapter and power cord.

Note: External power supply must be a UL Listed power supply.

Note: If the winder does not turn on, particularly if using an older model winder, the 
external power connector may have to be connected internally. Call your service 
technician.

11 Winder Interconnect Port - N/A.
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Chapter 2: Installing the Printer

Contents of Packaging
Unpack the printer. Make sure that all parts are included and verify that no items were damaged in 
transit.

Before Using the Label Printer
• Choose a location for the printer (plus optional U1C-L unwinder and W1C-L winder if used).

• Unpack the printer (plus optional U1C-L unwinder and W1C-L winder if used).

• Remove shipping materials from the printer.

• Install the ink drip tray.

• Plug in the printer and connect it to a computer or network.

• Install the printer driver.

• Install the ink tanks and the printhead.

• Align and connect the printer with the U1C-L unwinder and W1C-L winder (If used).

• Set up the feed on the printer.

Unpack and Set Up the Printer
Remove the printer and its parts from the carton. Remove all packing materials and tape. Install 
the ink drip tray assembly before operating the printer.

# Description

1 QL-900 Label Printer

2 Ink Drip Tray Assembly

3 Five Ink Tanks - Cyan, Magenta, Yellow, Black, Black

4 Printhead Cartridge

5 AC Power Cord

6 USB Cable (10-Ft.)

7 Ethernet Cable (10-Ft.)

U1C-L Unwinder (Optional): Includes Printer/Unwinder Adapter Plate and (2) 
thumbscrews

W1C-L Winder (Optional): Includes Printer/Winder Adapter Plate, (1) AC Adapter, 
(2) thumbscrews, and (2) screws

Note: Requires a Power Cord, available separately
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Choose a Location
Place the printer on a sturdy level worktable or cabinet at least 9 inches from any walls.

Open the ink tank door and raise the clamshell assembly. Use the bubble gauge mounted on the 
ink station frame, or a small level placed on the ink station frame, to make sure the printer is level. 
Protect the printer from excessive heat, dust, and moisture. Avoid placing it in direct sunlight.

Remove Shipping Materials
Warning: To avoid possible damage to the printer, do not plug in or power up the printer until all 
shipping materials are removed.

1. Open the top cover.
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2. Remove the foam shipping block [A]. The color of the foam block may vary.

Note: The foam shipping block is used to secure the service station sled during transport.

3. Cut and remove the two yellow zip ties [B].

Note: These zip ties are used to secure the wiper motor assembly during transport. Do not cut 
the white or black zip ties used to restrain the ink hoses.

Important: Remove all cut pieces of the yellow zip ties from the printer.

4. Gently close the top cover.

5. Remove the protective film from the touchscreen.
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Install Ink Drip Tray Assembly

1. Open the ink tank door [A].

2. Release the latch [B] to raise the clamshell.
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3. Insert the tabs on the ink drip tray into the frame slots [C] as shown.

Note: If necessary, bend the tab on the grounding spring [D] so it touches the bottom of the 
ink drip tray tab.

4. Close the clamshell.

Install Unwinder/Winder Adapter Plates
The adapter plates allow proper spacing and alignment for the optional unwinder and winder.

Unwinder
1. Unscrew the two unwinder feet closest to the printer.

2. Install the long edge of the adapter plate under the unwinder [A].

Reinstall the two feet to secure the adapter plate to the unwinder.
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3. Align the adapter plate with the two pre-drilled holes at the base of the feed end of the printer. 
Secure with (2) thumbscrews [B].

Winder
1. Attach the adapter plate to the left-side base of the winder using the (2) screws provided [A].

2. Align the adapter plate with the two pre-drilled holes at the base of the exit end of the printer. 
Secure with (2) thumbscrews [B].

3. Plug the AC adapter into the auxiliary port [C] on the rear of the winder. Plug the power cord 
into the AC adapter and into a grounded AC wall outlet.

Alignment
Test the alignment. Run a job. If extreme web drifting is observed or the web runs to one side, 
readjust the unwinder or winder alignment. Loosen the two adapter plate thumbscrews. Slide the 
unwinder and/or winder forward or backward as needed, and then tighten the screws. Readjust as 
needed.
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Connect the Printer

Plug in the Printer
Plug the power cord into the receptacle [1] located on the rear panel of the printer. The internal 
power supply in the printer is rated 100 to 240VAC, 50/60 Hz.

Caution: Do not use adapter plugs or extension cords to connect the printer to a wall receptacle.

Caution: Do not use outlets controlled by wall switches.

Caution: Do not use outlets that share the same circuit with large electrical machines or 
appliances.

Connect to a Computer
The printer connects to the computer through the USB port [2].

Use the network port [3] for connecting to a network.

Once the printer is connected and set up, opening the printer toolbox displays the printer(s) 
available and whether they are connected to the network or by USB cable. You can then select the 
desired printer to open its toolbox screens.

Note: If the symbol is grayed out or blank, that printer is not currently connected.

Turning Power ON and OFF
Important: Close all covers and doors before starting or powering down the printer.

Important: Start one printer at a time when similar printers are on the same network.

Powering Up the Printer
1. Press the main power switch on the rear panel.
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2. Press the power button on the control panel.

Powering Down the Printer
Caution: When powering down the unit, always follow these instructions.

1. Close all doors.

2. Press the power button on the control panel.

3. Wait for the printer to stop processing.

4. Then press the main power switch on the rear panel.

Install the Printer Driver
For the printer software to operate properly, check that the hardware meets the minimum 
requirements:

• Operating System: Windows 10 and 11. Supports 32 and 64-bit systems. You must have 
administrative privileges on the system.

• Microprocessor: Pentium II, 2 GHz minimum (Pentium Dual Core, 2.5 GHz or better is 
optimal)

• System memory: 2 GB minimum, or as recommended for your operating system.

• Free hard-disk space: At least 10 GB.

• Web Browser: Firefox is recommended. Chrome, Safari, and Opera are also supported.

• Ethernet Speed: 1,000 Mbps.

• USB port (2.0/3.0): Ports will be identified as “USB” or “Enhanced” in Device Manager.

• Microsoft .Net Framework version 3.5 (for 32-bit systems) or Microsoft .Net Framework 
version 4 (for 64-bit systems) must be installed. Even if a newer .NET Framework version is 
installed, version 3.5 or 4 must also be installed or Toolbox will not open.

Important: Before installing the printer software (Toolbox and driver), temporarily disable all anti-
virus programs and firewalls. In addition, you must be logged into the system with full 
administrative privileges.

Note: If installing over USB, do not plug in the USB cable until prompted.

Install Over USB Connection
This is the procedure for installing the printer driver over the USB connection. The procedures for 
installing the printer driver over a network connection follow.

1. Check that the printer is plugged in and turned OFF. Disconnect the USB connection if it is 
already plugged in.

2. Download the QL-900 driver from https://quicklabel.com/support/downloads/. Save the file to 
your desktop for convenience. This file is a self-extracting executable file with a .exe 
extension. Double-click the installer file.

3. Install the printer software. Make sure the system meets minimum requirements and you 
followed the other instructions listed on the screen. Click Install Printer Software.

4. Accept the license agreement. Check I accept… then click Next.
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5. Select a printer connection method. Click Configure to print using USB. Then click Next.

6. Installing the printer software. The software download begins.

7. Click Install when prompted by Windows to install the software.

8. Connect the device when prompted. Turn the printer ON and connect the USB cable. Don't 
click on either button. The software will finish installing.

9. Finish the software installation. Do not check Print Test Page as the printer is not set up yet. 
You can check Set this printer as the default printer at this time. Click Finish.

10. Click Exit to close the program.

11. Restart computer to complete the installation.

Install Over Network Connection (Version A)
Use this procedure to install the printer driver over the network connection. This procedure works 
for almost all networks that allow automatic assignment of the IP address (factory default).

Note: Copy the 12-digit Hardware ID number listed on the printer(s) on the label located below the 
Ethernet port so you can identify the printer(s) in a later step.

1. Check that the printer is plugged in and turned OFF. Disconnect the USB connection if it is 
already plugged in.

2. Download the QL-900 driver from https://quicklabel.com/support/downloads/. Save the file to 
your desktop for convenience. This file is a self-extracting executable file with a .exe 
extension. Double-click the installer file.

3. Install the printer software. Make sure the system meets minimum requirements and you 
followed the other instructions listed on the screen. Click Install Printer Software.

4. Accept the license agreement. Check I accept… then click Next.

5. Select a printer connection method. Click Configure to print using the Network. Make sure 
the printer is connected to the network. Then click Next.

6. A list of available printers opens. Check the Printer column to verify you have a QL-900 series 
printer. Check the Hardware ID column and match the number listed to the number you 
copied previously from the printer label. Select that printer. Click Next.

Note: If the printer does not appear on the list, the IP address may have to be assigned 
manually. See “Install Over Network Connection (Version B)” on page 26.

7. Installing the printer software. The software download begins.

8. Click Install when prompted by Windows to install the software.

9. Finish the software installation. Do not check Print Test Page as the printer is not set up yet. 
You can check Set this printer as the default printer at this time. Click Finish.

10. Click Exit to close the program.

11. Restart computer to complete the installation.
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Multiple Printers
To help distinguish between multiple QL-900 series drivers on your system, open the Printers and 
Faxes (Devices and Printers) folder and rename the printers. For example, rename a network-
configured printer “QL-900 (Network-1)” and a USB-configured printer “QL-900 (USB)”.

To open the Toolbox utility over an Ethernet (network) connection, click Start > All Programs > 
QL-900 Driver > Toolbox.

If more than one copy of the driver is installed, you must choose which device you want the 
Toolbox to connect to. To help choose the proper device, you can identify the printer using the 
hardware ID you copied earlier or you can rename the printer as outlined above.

Driver Naming Examples

Description Connection Suggested Name

Driver USB QL-900 (USB)

Driver (Copy 1) Network QL-900 (Network-1)

Driver (Copy 2) Network QL-900 (Network-2)
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Install Over Network Connection (Version B)
Use this procedure to install the printer driver over the network connection on static IP systems 
requiring that an IP address is assigned manually.

Note: Copy the 12-digit Hardware ID number listed on the label located below the Ethernet port so 
you can identify the printer in a later step.

Note: This procedure can also be performed from the touchscreen or Toolbox.

1. Touchscreen: In the Menu, tap Setup. On the Service screen, tap Network Config. The 
Network Config screen opens. Uncheck the DHCP button. You or your IT support person can 
enter the necessary information under Network Configuration. Tap Submit.

Toolbox: Install the printer software over a USB connection using a nearby computer or 
laptop. Once the driver and firmware are installed on the printer, use that same computer to 
open the Printer Toolbox.

In the View drop-down menu, click Service Menus. When the Diagnostic screen opens, click 
the System Settings button. The System Settings screen opens. Uncheck the DHCP button. 
You or your IT support person can enter the necessary information under Network Settings. 
Click Submit.
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Note: Disconnect the USB cable from the local computer or laptop. If you are not using that 
computer for printing, the software can be uninstalled.

2. Connect the Ethernet cable to the Ethernet port and rerun the installation procedure. See 
“Install Over Network Connection (Version A)” on page 24. The printer should now appear in 
the Printers Discovered window. The printer can still be identified by its Hardware ID, but the 
new IP address entered is shown.

Select the desired printer and click Next. Follow the remaining steps.

3. Installing the printer software. The software download begins.

4. Click Install when prompted by Windows to install the software.

5. Finish the software installation. Do not check Print Test Page as the printer is not set up yet. 
You can check Set this printer as the default printer at this time. Click Finish.

6. Click Exit to close the program.

7. Restart computer to complete the installation.

Multiple Printers
To help distinguish between multiple QL-900 series drivers on your system, open the Printers and 
Faxes (Devices and Printers) folder and rename the printers. For example, rename a network-
configured printer QL-900 (Network-1) and a USB-configured printer QL-900 (USB).

To open the Toolbox utility over an Ethernet (network) connection, click Start > All Programs > 
QL-900 Driver > Toolbox.

If more than one copy of the driver is installed, you must choose which device you want the 
Toolbox to connect to. To help choose the proper device, you can identify the printer using the 
hardware ID you copied earlier or you can rename the printer as outlined above.

Driver Naming Examples

Description Connection Suggested Name

Driver USB QL-900 (USB)

Driver (Copy 1) Network QL-900 (Network-1)

Driver (Copy 2) Network QL-900 (Network-2)
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Install Ink Tanks
The printer uses one printhead cartridge and five ink tanks (two black, one cyan, one magenta, 
and one yellow).

1. Look at the control panel touchscreen.

Ink tank status information appears on the right side of the touchscreen. Note that the ink tank 
indicator boxes are empty.

Note: The question marks indicate that no ink tanks are detected by the printer.

Caution: Verify that the labels on the ink cartridge and the printer’s ink station match. Both 
should be “DN”.

2. Open the ink tank door (hinged at the bottom). Opening the door disconnects the printer 
communication from the ink tanks and allows safe installation and replacement.

Open Ink Tank Latches [A].

3. Remove the new ink tanks from the packaging.

4. Insert the ink tanks (labels up) into the appropriate color slots [B]. Close the ink tank latches.

Note: Make sure the ink tanks seat properly. Insert the ink tank into the appropriate ink station. 
Pull the ink tank back about an inch and then push forward firmly to ensure that the ink nozzles 
penetrate the seals on the ink tanks.
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5. Close the ink tank door. Ink colors fill in as the ink tanks are installed. If the ink colors do not fill 
in after a few seconds, open the ink tank door again and reinstall the ink tanks.

Warning: Ink in ink tanks may be harmful if swallowed. Keep new and used ink tanks out of 
the reach of children. Discard empty tanks immediately.
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Initial Printhead Cartridge Installation
The printhead cartridge is a delicate precision device. Handle with extreme care to avoid damage 
and issues that could degrade print quality.

Caution: Use electrostatic discharge (ESD) protection when handling.

Caution: Hold the printhead cartridge by the handles ONLY.

Caution: DO NOT touch the ink couplings, nozzle surface, or electrical contacts.

Caution: DO NOT unpack the printhead cartridge until the printer is ready for installation. Once 
unwrapped, delay in installing the printhead can compromise print quality due to dehydration.

Caution: DO NOT place an unwrapped printhead on any surface before installing. Protect the 
printhead from scratches, dust, fibers, dirt, and other contaminants at all times.

1. Open the top cover.

The printhead latch [1] is shipped in the open position. If it is not, close the top cover.
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Use the touchscreen to tap Menu, then Setup. Press Release Printhead. The printer runs, 
then the Latch [1] opens. Open the top cover.

Note: Remove the cap protectors [2] on the ink nozzles. Be sure to open the latch fully to 
retract the ink nozzles.

Caution: Do not pry or manually lift the printhead latch or the latch may break. Only open the 
latch using the release printhead button on the touchscreen or in the printer Toolbox.

2. [A] Carefully remove the printhead cartridge from the foil packaging. Tear the foil at the notch 
or cut the end with scissors.

[B] Remove the protective plastic cover. Hold the printhead by its handle and unclip the cover 
from the printhead.
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[C] Remove the protective strip from the printhead electrical contacts. Once removed, DO 
NOT allow the strip to touch the electrical contacts.

[D] Remove the protective strip from the printhead nozzles. Hold the printhead by the handle. 
Pull the strip tab and slowly peel the strip from the printhead.

DO NOT pull the strip at less than a 45° angle from the printhead surface.

DO NOT allow the removed strip to touch the printhead nozzles.

3. Wet the printhead surface to ensure that the printhead will prime correctly. Moisten the 
printhead nozzles using distilled water and a damp, lint-free cloth, wiping end to end. (Gray 
strip located below the orange strip.) Take care not to damage the copper contacts, metal 
plate, or gold printhead surface.

4. Carefully insert the cartridge into the compartment at an angle [4], with the printhead surface 
facing down and the ink nozzles facing the ink hoses. Once the cartridge is seated, gently tilt it 
back until it snaps into an upright position [5]. DO NOT FORCE cartridge into position.
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5. Close the printhead latch [6]. Close the top cover. The printer starts up and primes ink into the 
printhead (this may take a few minutes).

Note: When priming stops, open the top cover and check that ink is flowing through the hoses. 
If air bubbles appear, tap the lines and close the top cover. Or close the top cover and click 
Circulate Ink on the touchscreen to clear the air bubbles.

6. Watch the control panel touchscreen. Check that the printhead icon [7] in the printer image is 
primed (solid color).

7. When ONLINE [8] appears, the printer is ready for use.

If the printhead icon continues to display an outline or a question mark (?), try the following 
procedures:

• Printhead icon shows an outline (printhead unprimed): Click Circulate Ink under the 
Maintenance drop-down menu in the printer Toolbox. If the issue persists, try the Install 
Printhead procedure again. If this does not resolve the issue, contact technical support.

• Printhead icon displays a question mark (printhead not recognized): Try the Install 
Printhead procedure again. If the issue continues, contact technical support.

Note: The printer may take up to 12 minutes to set itself up during initial startup. This is normal.
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Connect the Printer to an External Device
Warning: Hazardous moving parts! Keep fingers and other body parts away!

Warning: Make sure that the printer is turned off before connecting an external device.

Connect one end of the interconnect cable into the 9-pin connector port on the printer [1] (located 
just below the USB port).

Load Media
Setting the Adjustable Media Sensor
For irregular-shaped media (such as a circle), loosen the sensor reflector knob.

Pin # Description In/Out MPCA 
Connection

MPCA 
GPIO Bias RTI Name

1 3.3V P900-1

2 Page Printing or 
Maintenance (R1.5.1)

Out P900-10 B13 OAH PAGE_PRINTING 
or MAINTENANCE

3 Print job ready Out P900-11 E19 OAH JOB_AVAILABLE

4 External device ready/not 
ready

In P900-12 B14 IAL EXT_PAUSE_REQ
UEST

5 Printer error Out P900-13 E18 OAH ERROR

6 Low (ground) P900-20

7 Reverse paperpath 
direction

Out P900-14 B15 OAH MOVE_BWD

8 End Of Roll or Job 
Cancel (R1.5.1pre09)

In P900-15 E03 IAL EOR or 
JOB_CANCEL

9 Move Media Forward 
(last job speed) 
(R1.5.1pre09)

In P900-16 B16 IAL FWD_MOVE
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Slide the sensor reflector along the track so the straight edge of the sensor [A] aligns with the 
leading tip of the media [B]. Tighten the knob to lock the sensor reflector in place.

Roll-to-Roll Label Printing
Make sure the unwinder and winder are properly connected and turned ON. Proper alignment of 
the unwinder, printer, and winder is critical to operation of the label printer. Position the printer on a 
sturdy, stable, level work surface with enough room to place the unwinder and winder at either 
end.

Roll-to-Cut Label Printing
Make sure the unwinder is properly connected to the printer and turned ON. The winder should be 
turned OFF and moved out of the way. Proper alignment of the unwinder and printer is critical to 
the operation of the label printer. Position the printer on a sturdy, stable, level work surface with 
enough room to place the unwinder at the feed end of the printer.

Connect the Optional Unwinder and Winder
Warning: Hazardous moving parts! Keep fingers and other body parts away.

Caution: Make sure that the printer is turned off before connecting the unwinder and winder.

Connecting the Printer to the UW-1C Unwinder
Connect one interconnect cable into the 7-pin connector port on the printer [1] (located just below 
the USB port).

Connecting the RW-1C Winder to Power
Connect the AC Adapter to the 24V, 2.5A External Power Connector [2] (located on the winder 
rear panel). Plug the power cord into the AC adapter and into a wall outlet.

Note: If the winder does not turn on, particularly if using an older model winder, the external power 
connector may have to be connected internally. Call your service technician.
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Unwinder Mode Switch
The unwinder has a Mode switch for Auto or Manual operation. When used with the printer, the 
unwinder can be left in the Auto position.

• Auto - The unwinder is OFF. The unwinder is controlled by the printer (or other external 
device) through the interface cable. This allows easy roll loading since the unwinder will not 
start turning when the drive press roller is lifted. It will turn only when the printer is running a 
job.

• Manual - The unwinder is always ON. When the drive press roller is balanced (in the center 
position of its arc), the unit is OFF. If tension from the media increases (roller raises), the unit 
turns clockwise to relieve tension. If tension from the media decreases (roller drops), the unit 
turns counterclockwise to increase tension. This is useful if using the unwinder with a non-
interface external device.
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Loading Labels

Roll-to-Roll Printing
Important: Make sure the unwinder is connected to the printer.

The printer is equipped with one adjustable side media guide. Make sure the unwinder is set to 
Auto, and the winder (if used) is turned OFF, and that both are connected to the printer via the 
appropriate ports.

1. Adjust core size (unwinder only):

Unwinder can fit 1-1/2" or 3" cores using the reversible hub assembly.

To change core sizes:

[A] Carefully remove the retaining clip holding the hub assembly in place.

[B] Slide the hub assembly off the shaft.

Note: Do not lose the key in the shaft slot.

Each side of the hub fits a different size core. The larger side fits 3" cores. The smaller side fits 
1-1/2" cores.

[C] Turn the hub so the desired core size is facing out. Slide the hub assembly back into place 
over the key in the shaft.

[D] Reinstall the retaining clip into the groove cut in the shaft.
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2. Load a label roll:

[A] Slide the roll onto the unwinder shaft, labels facing up, with the roll end facing the printer.

[B] Slide the roll lock onto the unwinder shaft until the 4 pins fit into the roll core.

[C] Pull the roll leader under the drive press roller, and under the crossbar. Raise the brush 
assembly and push the leader to the entry of the print engine. Lower the brush assembly.

Note: Position the drive press rollers evenly on the label or labels, but not on the label 
backing. See the illustration below.

[D] Align the side edge of the roll with the two alignment pins on the printer and feed the roll 
end into the print engine.

[E] Slide the adjustable side guide until it just touches the labels. Tighten the locking knob on 
the adjustable side guide.

3. Choose Menu > Paper Path > Load. The printer aligns and pulls the labels into the printer.

As an alternative, you can print a job and then pause it to attach labels to the rewinder.
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4. [A] Load an empty 3" core on the winder spindle. Slide the spindle lock on the shaft until the 
4 pins fit into the roll core.

[B] Take the leader end and pull it under the label tension arm on the winder.

[C] Tape or glue the roll end (label side up) to the top side of the empty core.

Note: Make sure the edge is secured straight on the core for proper winding.

[D] Slide the adjustable media ring guide on the label tension arm to the edge of the media.

Adjusting Speed on U1C-L Unwinder and W1C-L Winder
For proper media feeding and printing, adjust the speed on the unwinder and winder depending on 
the type of media and job you are running.

To increase the unwinder and winder speed, turn the Speed control clockwise.

To decrease the speed, turn the Speed control counterclockwise.

Caution: Setting the unwinder speed too high can cause media to hesitate as it unwinds and 
affect print registration.
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Adjusting Winder Tension
Use the Tension Control selector [A] to adjust spring tension on the label tension arm for different 
label stock widths.

Use the 0 setting (least tension) for narrow label stock and the 4 setting (highest tension) for the 
widest label stock.

Note: Setting tension improperly can cause the print to misregister due to the label stock being 
pulled with too much force. If this occurs, try decreasing the tension (set at a lower number). If the 
tension is set too low, the roll may not be rewound properly.

Roll-to-Cut Labels
Important: The winder must be turned OFF or disconnected from the printer and moved out of the 
way.

Load the label roll on the unwinder and printer using steps 1-2 in Roll-to-Roll Printing above. See 
“Roll-to-Roll Printing” on page 37. Then choose Menu > Paper Path > Load. The printer will align 
and pull in the labels.

Printing Fanfold Labels
Important: Make sure both the unwinder and winder are turned OFF or disconnected from the 
printer and moved out of the way.

Loading Fanfold Labels
1. Place the fanfold labels label-side up next to the feed end of the printer.
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2. Feed the labels under the brush and into the printer, aligning the left-side edge with the 
alignment pins on the printer. Feed the label end into the print engine.

3. Slide the adjustable side guide so it just touches the right-side edge of the labels.

4. Choose Menu > Paper Path > Load. The printer aligns and pulls the labels into the printer.

Bleeds
See “Borderless Printing” on page 120.
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Chapter 3: Operating the Printer

Once the printer driver is installed and the printhead is primed, you are ready to start printing. Set 
up your job and send it to the printer. The printer will start and print.

Set the printer driver as the default driver. It is then accessible through your applications (such as 
Microsoft Word). Other types of applications and database management software will work in a 
similar manner when using this driver.

Printer Driver Properties
The printer driver works the same as any other printer driver for Windows. It does have some 
enhancements to help maximize the printer's ability to print variable addressed pieces quickly and 
efficiently.

Once the job is set up, click File, then Print. Make sure the QL-900 driver is the selected printer. 
Clicking Printer Properties opens the General tab window.

General Tab
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The General tab lets you select:

• Orientation - Set the print direction as Portrait (default), Landscape, Rotate 180°, and 
Mirrored.

• Job Management - Stitch is for printing on continuous media (no gaps).

Buffer loads the entire print job before printing starts.

Mask Optimization optimizes images for printing in most applications. This option is checked 
by default.

Note: Some applications (like FlexMail) may display image boundaries when printed. 
Unchecking the Mask Optimization box eliminates these lines. Remember to check the box 
when changing applications.

Printer Capture - When selected, the printer stores the print job in the printer Job Library 
after the job is printed.

Note: The Stored Jobs button on the printer touchscreen accesses the Job Library.

PC Capture - When selected, saves a print file (*.prn) on the PC (C:\Windows\Temp) for later 
use. This option is not checked by default.

Note: Use the box below the selection to name the file. Otherwise, the printer assigns the 
current date and a numerical name.

• Copies - Enter the number of copies to be printed.

Reverse Order: When this box is checked, the job will start printing from the last page of a 
document and end on the first page.

Collate: When printing multiple copies of multi-page documents, checking the box allows all 
pages of the document to be printed in proper order before printing the next copy.

• Media - Adjusts the printer for media being used for a job.

Ink Type: Displays the ink type for this model.

Type: Choose the type of media to be used.

Size: Set a different size media than the document was originally designed for. The document 
is automatically resized to fit the new media.

Borderless Printing: Checking this box allows printing to the edge of the media. See 
“Borderless Printing” on page 120.

• Custom Size lets you create and save a custom size to suit your needs.

• Color Selection - Set printing for Color, Composite Black (uses all colors to print black), or 
Black Only (uses only black ink).

• Print Quality - Select Normal or Best. Normal is 1600 x 800 dpi. Best is 1600 x 1600 dpi, for 
use when high quality images are required. Speed allows you to adjust the printer speed for 
the media being used (for example, decrease the printing speed for higher quality on glossy 
stock).

• My Print Settings - Access saved custom print settings for various jobs.
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Layout Tab

Layout allows you to change how the document prints without changing the original document.

• Resizing - Specify Original Size or Custom Resize. This resizes the original as a percentage 
of normal size. The printer prints the document in the size you selected regardless of the 
paper size selected.

Print on: Specify a size of paper to print on regardless of the size of the original document. 
Checking Scale to Fit automatically resizes the document to fit the new page size.

• Watermark - Prints a light background watermark while printing the original document. When 
selected, the First page only option prints a watermark on the first page, but not subsequent 
pages. Unchecking this option prints the watermark on all pages.

Custom button lets you create a new watermark or edit an existing watermark, including font 
selection, color, size and printing angle.
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Color Tab

Color is used to adjust the color output of the printer. Use the sliders to adjust Color Tone, 
Brightness and Saturation. The C, M, Y, K sliders adjust individual colors. Use Defaults to reset 
to 0 settings.



Operating the Printer

QL-900 User Guide 46

Media Tab

Media tab shows the type of media the printer is configured to run and allows minor changes to 
the positioning and cutting of the media.

• Media - Displays the type of media currently selected for the printer. Press Refresh to update 
the display.

• Printing Adjustments - (Top, Left and Bottom Adjustments plus Max Page Width and 
Interpage Gap.) Make minor positioning changes to the print area in relation to the media if 
needed.

Note: Printing adjustments only work when the print area is less than full print width (less than 
8.5"/215.9mm wide). See “Using Media Tab Printing Adjustments” on page 48.

Stitch - When selected, prints the entire document as a single page (no gaps).
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Label Frequency - Allows the printer to ignore a set number of gaps between labels. This is 
particularly useful when the labels are different shapes and the printer sensor may not sense 
the edge of the second label correctly. For example, printing both front and back bottle labels 
in one pass. A label frequency of 1 reads the gap between every label. A setting of 2 will 
ignore the gap between the two labels [A]. In effect, the printer “sees” the two labels as one 
label. The Label Frequency can be set from 1-8.

Note: Using this feature requires that the job be set up as one label in the layout software, so 
the dimensions (including the gap) must be accurate.

Example of a Label Frequency of 2:

• Page Cutting - Sheets per Cut: Set the number of labels (sheets) between cuts. For example, 
1 will cut after every label. 5 will cut after every fifth label.

Note: Since End of Job Cut will also be active, the last cut may have fewer labels than set 
Pages per Cut number depending on the total number of labels you are printing. For example, 
if you print a total of 23 labels set to cut after every fifth label, you will have 4 sets of 5 labels, 1 
set of 3.

End Job Cut: When checked, cuts the end of the media after the job finishes printing.

Cutter Offset: Allows fine tuning of the cut line position after making image positioning 
adjustments.

• Units - Set measurements to be in Inches or Millimeters.



Operating the Printer

QL-900 User Guide 48

Using Media Tab Printing Adjustments

• Top Adjustment /Top of Form (TOF) - Moves the image up or down (-5mm up to +200mm 
down) from the top left corner of the media used.

• Left Adjustment - Moves the image area away (-3mm left to +200mm right) from the left edge 
of the media. (0.1mm increments)

• Bottom Adjustment/Bottom of Form (BOF) - Extends BOF (in 0.1mm increments) to allow 
printing over the edge of a label (full bleed label printing).

• Max Page Width - Sets the width of the actual print area (0.1mm increments). This shuts off 
nozzles in the non-printing area (not used for printing) and saves ink.

Note: This can be no larger than the maximum print width for the printer (8.5"/215.9mm).

• Interpage Gap - Sets a gap between labels (pages) when using continuous media.

Note: Minimum gap (default) is 3mm.
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Import/Export Tab

Import/Export is used to preserve any custom Watermarks, Media Sizes, and/or Print Settings 
you may have developed and saved for various jobs when you update the printer firmware.

• Export - Send custom settings to a holding file before downloading the new firmware.

• Import - Return custom settings after the firmware installation is complete.

The Import/Export tab is also used to import custom media size packages or watermarks from 
your dealer if they are available.

Important: Before updating any printer firmware, remember to first export any custom Media 
Sizes, Watermarks, or Print Settings you have added to an outside holding file. This prevents the 
loss of your custom settings.
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Using the Printer Touchscreen
Once the printer driver is installed, and the printer is turned ON, you can use the printer's 
touchscreen. You can check the printer status, monitor ink usage, perform diagnostic checks, print 
reports, and run maintenance tasks on the printer from the touchscreen.

Note: These functions and more can also be operated remotely from a computer using the Printer 
Toolbox. See “Using the Printer Toolbox” on page 69.

Tap the screen to view the printer touchscreen.

[A] System Status Indicator

[B] Drop-Down Menu Options

[C] Check Printer Status

[D] Three often-used control buttons



Operating the Printer

QL-900 User Guide 51

Drop-Down Menu Options

The Menu drop-down gives you nine selections:

Job, Setup, Test Print, Maintenance, Paperpath, Media Scan, Wiper, System Test, and Videos.

Note: The Videos menu is only available when MP4 video files are loaded on the printer.
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Job (Status Screen)
The opening screen provides information about the status of the printer.

Status Indicator box shows the printer activity as ONLINE, ERROR, MAINTENANCE, PRINTING, 
or PAUSED. The gray box below the status indicator shows the name of the job being processed.

System Status displays the status of the printer and/or error message.

Page shows the page count for a given job.

Maintenance counts down from a specified preset length of printed media until the next automatic 
printhead maintenance is performed by the service station. Select the length by opening the 
Printer Toolbox User Interface screen, Mid-Job Servicing. In this example, service is performed 
every 40 meters (131-ft.).

Job shows number of jobs printed (resettable).

Session shows the total number of pages printed by the printer (resettable) over the length of a 
session (shift, day, week, etc.).

Firmware: UI Version displays the current firmware and UI firmware (touchscreen) versions 
currently installed on the printer.

Date and Time shows the current date and time. These can be configured and set by opening the 
Service screen, then Network Config, then Date and Time.

Relative Humidity (RH) displays the current ambient humidity detected near the printer.

Important: The RH percentage on the screen enlarges and blinks if the relative humidity 
consistently falls below 30%.

Printer messages may appear under RH (Relative Humidity).
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Media Icon: Displays the type of media the printer is currently configured for (Continuous, Diecut, 
or Black Mark). Set the type of media by tapping the icon and selecting the appropriate media type 
or using the media scan function after selecting Service from the Menu drop-down.

Printhead Height Icon: Shows the current printhead printing height setting. (3 dots = Low, 
Normal, High settings) Set on the Toolbox User Interface screen, Print Height.

Printer Icon: Shows the status of the media sensors located in the media feed path of the printer. 
Also shows the status of the ink valves, service station, and printhead. These can alert the 
operator to the type and location of a problem. (See icon key above.) Tapping any of the status 
icons opens a description of that icon.

Ink Levels displays the percentage of ink remaining in each of the ink tanks.

Control Buttons (located along the bottom of the screen): Provide quick access to often-used 
functions.

Pause: Tap to temporarily stop printing. Tap again to resume printing.

Cancel Job: Cancels a paused job from the printing queue. Cancel is unavailable unless the 
Pause button has been pressed first. Canceled jobs must be reloaded before printing can resume.

Stored Jobs: Opens the printer's Job Library to access print jobs saved in the printer's memory. 
You can also make changes to the job specifications and delete jobs as needed. See “Using 
Stored Jobs (Print Job Library)” on page 54.

Note: If no jobs are saved on the printer, this button will be inactive.

Clear Error: Click to clear error messages after a printer problem is resolved (for example, after 
clearing a paper jam).
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Using Stored Jobs (Print Job Library)
Print jobs can be saved to the printer's Job Library by selecting the Printer Capture option under 
Job Management on the General tab of the printer driver. You can access jobs saved in the 
printer's Job Library using the Stored Jobs button on the Jobs screen.

Note: If no jobs are saved on the printer, this button will be inactive.

To view the printer's Job Library, press Stored Jobs on the Jobs touchscreen. The Jobs Library 
opens.

Use the View button [A] to change the library view from icon to list.

Use the Search icon [B] to search for a print job.

The Exit button [C] returns you to the Jobs (Status) screen.

The Printer icon [D] prints the selected job.

The Trashcan icon [E] (list view only) deletes selected jobs (checked in the Delete column in the 
Jobs List) from the library.

The Disk icon [F] displays the available space left in the printer's Job Library memory.



Operating the Printer

QL-900 User Guide 55

List View:

Search Screen:

Select a job by tapping the job icon or the list name. The Job Print Options screen opens.

The (4) Control buttons let you Exit, Print, Save, or Delete the print job. The Save button saves 
any changes you make to the job specifications in the Print Options on the right side of the 
screen. If you do not tap Save, the print job reverts to its original settings when you Exit.
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The Print Options allow you to change or adjust print specifications for the print job. Scroll down 
the screen to access all options.

• Quality - Tap the button to select Normal or Best. Normal is 1600 x 800 dpi. Best setting is 
1600 x 1600 dpi.

• mm or inches - Tap the button to change measurements to millimeters or inches.

• From page and To page - Select the first and last pages of a job (or part of a job) to print 
using the Up or Down arrows.

• Copies - Enter the number of copies to be printed.

• Left Adjustment - Moves the image area away (-3mm left to +200mm right) from the left edge 
of the media. (Up or down arrows move in 0.1mm increments)

• Max. Page Width - Sets the width of the actual print area. (Up or Down arrows move in 0.1mm 
increments) This shuts off nozzles in the non-printing area (not used for printing) and saves 
ink. Can be no larger than the maximum print width for the printer (8.6"/220.8mm).

• Top Adjustment - Moves the Top of Form (TOF) image up or down (-5mm up to +200mm 
down) from the top left corner of media used.

• Bottom Adjustment - Extends the Bottom of Form (BOF) (in 0.1mm increments) to allow 
printing over the edge of a label (full bleed label printing).

• Interpage Gap - Sets a gap between labels (pages) when using continuous media. The 
minimum gap (default) is 3mm.

• End Job Cut - When checked, cuts the end of the media after the job finishes printing.
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• Sheets Per Cut - Set the number of labels (sheets) between cuts.

For example, 1 will cut after every label. 5 will cut after every fifth label.

Note: Since End of Job Cut will also be active, the last cut may have fewer labels than the set 
Pages per Cut number depending on the total number of labels you are printing. For example, 
if you print a total of 23 labels set to cut after every fifth label, you will have 4 sets of 5 labels, 1 
set of 3.

• Normal Speed - Adjust the printer speed for the Normal Quality setting and for the media 
being used (for example, decrease the printing speed for higher quality on glossy stock).

• Best Speed - Adjust the printer speed for the Best Quality setting and the media being used 
(i.e., slow the printing speed for higher quality on glossy stock).

• Cutter Offset - Allows fine tuning of the cut line position after making image positioning 
adjustments.

• Label Frequency - Allows the printer to ignore a set number of gaps between labels. This is 
useful when the labels are different shapes and the printer sensor may not sense the edge of 
the second label correctly.

For example, printing both front and back bottle labels in one pass. A label frequency of 1 
reads the gap between every label. A setting of 2 will ignore the gap between the two labels. In 
effect, the printer “sees” the two labels as one label. The Label Frequency can be set from 
1-8.
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Setup Screen
Tap the Menu button, then the Setup button to open the Setup screen.

• Release Printhead - Pumps ink back into the ink tanks and opens the printhead latch to 
remove or install the printhead cartridge. Button is only active if the system is deprimed first.

• System Deprime - Pumps ink back into the ink tanks prior to replacing the printhead cartridge 
or transporting the printer.

• Network Config button. Click to view, enter, or change settings to connect the printer to your 
network. You can also set the Screensaver Timeout (sleep delay) and printer Date and Time. 
See “System Settings” on page 80.

• Restart - Restarts the printer without having to perform the shutdown routine (purging ink 
tanks, priming, etc.)
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Test Print Screen
Tapping Menu, then Test Print opens the Test Print screen options for printing different reports.

• Print Color Bars - Prints a series of 7 color bars (per printhead) to indicate how well the 
printheads are mixing colors and printing.

• Print Setup page - Prints a printing pattern used for positioning an image on the page.

• Print Configuration - Prints the current printer configuration including Firmware Version, 
Network Connection, Printer Serial Number, and more.

• Print Printhead Test - Prints color bands, text, and patterns to check the condition of the 
printhead ink nozzles. This uses less ink than Print Color Bars.
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Maintenance Screen
Tapping Menu, then Maintenance opens the Maintenance screen. These buttons operate 
functions for printer and printhead maintenance.

• Inspect Sled - Moves the service station out from under the printhead assembly for 
inspection, cleaning, or service.

• Circulate Ink - Purges air from ink lines and primes the system after replacing the ink tanks or 
the printhead cartridge.

• Full Clean Printhead - Runs the cleaning routine multiple times for the most thorough flushing 
and cleaning of the printhead.

• Normal Clean Printhead - Runs cleaning and wiping routine twice for a more thorough 
flushing and cleaning than Quick Clean.

• Quick Clean Printhead - Circulates ink, wipes, and cleans the printhead cartridge.
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Paperpath Screen
Tapping Menu, then Paperpath opens the Paperpath screen. These buttons are used to move 
media through the printer when loading or unloading the printer.

• Unload - Rewinds the media back onto the unwinder and into the start position on the printer.

• Cut - Tap to cut the roll. The Cut button may change to Cut Position - In this instance, pressing 
the button advances the last printed label past the cutter, the roll is cut, and the media retracts 
to the start position.

• Load - Moves the media from the unwinder and into the start position.

• Reverse Arrow - Moves media back onto the unwinder. Pressing once moves media at a slow 
speed, and pressing again moves media at a faster speed.

• Stop - Stops the media from either advancing or rewinding.

• Forward Arrow - Moves media forward through the printer and onto the winder. Pressing 
once moves media at a slow speed, and pressing again moves media at a faster speed.
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Media Scan Screen
Use Media Scan to fine tune sensor sensitivity and/or adjust scan length if media is not printing 
correctly, or to determine if a type of media is going to have problems printing. This is generally 
due to the sensors having trouble differentiating between the label surface and backing/gap. See 
“Using Media Scan” on page 62.

Using Media Scan
1. Tap Menu, then Media Scan.

2. Media Scan screen opens. Tap the Label Icon to select the type of label being used (die-cut 
or black mark).

3. Set the Scan Length bar slider (set in mm in this example) so the length would include at least 
4 or 5 labels.

4. Load media in the printer.
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5. Tap Auto Scan. The touchscreen will display a graph together with results marked Legend 
and Edge Distances.

The graph shows the difference between the high points (gaps/backing) and flats (label 
media). If there is slight difference between the highs and the flats, the printer may have 
trouble differentiating the labels from the gaps.

Note: Tapping or rolling the cursor over the blue graph line provides readouts of the points on 
the graph.

Legend: Explains what the graph is showing. Media (TOF/BOF-Green line), and Sensor 
(Sensor-Blue line).

Edge Distances: The top line shows the average gap distance reading. The bottom line 
shows the length of the label reading.

This example uses a 1/8" (3.5mm) black-mark or gap with a 4" (101.6mm) long label.
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6. Manual Scan: For Advanced Users Only. Use Manual Scan if you wish to fine tune the 
results of the Auto Scan. First, make sure that the label type and the selected touchscreen 
label icon match. Only the sensors for that type of media will be active. If the label type is 
different, an error will show on the touchscreen status box. Adjust the Sensor Power and/or 
Sensor Sensitivity sliders in small increments. You can also increase or decrease the length of 
media to be scanned by moving the slider on the Scan Length bar. Tap the Manual Scan 
button. Repeat as necessary to get the desired result.

Sensor Power: 0 to 100

Sensor Sensitivity: 0 to 100

Scan Length: 0 to 1000mm (0 to 39.4")

Note: Media Scan is also available in the Toolbox on the computer. See “Media Scan” on 
page 83.

Wiper Screen
Tapping Menu, then Wiper opens the Wiper options screen. Selections are Wiper Transfer, 
Condition Wiper, and New Wiper.

• Wiper Transfer - Manually initiates a Wiper Transfer instead of waiting for a transfer to 
automatically occur during normal operating cycles. Squeegees excess ink off the service 
station wiper roller.

• Condition Wiper - Saturates, conditions, and cleans the wiper roller with ink to remove dried 
residue if the printer is left inactive for extended periods of time.

• New Wiper - Moves the service station out to remove and replace the service station wiper 
roller or wiper module. Once the new wiper or wiper module is installed, the printer primes with 
ink to condition the wiper to optimal operating condition. The Wiper Revolution Counter also 
resets to 0.

1. Press New Wiper. The service station moves out.

2. Open the top cover. Replace the wiper roller or wiper module.

3. Close the top cover. The printer primes with ink to condition the wiper and the Wiper 
Revolution Counter resets to 0.
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System Test
Note: These tests should only be performed by authorized service personnel.

System Test allows testing individual or all printer systems listed to check that they are operating 
within specifications. It also allows service people to check the printer after servicing or replacing 
parts, particularly belts.

Tap Menu, then System Test to open the Password screen. Enter the password and tap Submit 
to open the System Test screen.

Note: Prior to running the system test, make sure no media is loaded in the printer and there are 
no obstructions in the media path.
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Videos
MP4 video files can be uploaded to the printer using the control panel USB port. Access saved 
video files by tapping Menu, then Videos. This opens the Video Library screen.

Note: The Videos menu is only available when video files are loaded on the printer.

Note: Requires user interface (UI) firmware version 2.0 or higher.

Load video files with the USB port. See “Using the Control Panel USB Port” on page 67.

• [A] Video Library Playlist: Lists all video files available on the printer. Simply tap a title to 
play the video.

• [B] Trashcan icon: Deletes the selected video from the video library.

• [C] Viewing Mode button: Switch between single play (two-way arrows) or continuous loop 
(circular arrows).

• [D] Playing Time indicator: Shows how much of the video has played. The slider selector is 
also used to forward or reverse a video.

• [E] Stop button: Stops playing the selected video.

• [F] Play/Pause button: Pauses or restarts the selected video.

• [G] Exit button: Returns you to the Jobs (Status) screen.



Operating the Printer

QL-900 User Guide 67

Using the Control Panel USB Port
The USB port is located below the touchscreen. It can be used to back up stored print jobs and 
debug logs, upload print jobs, upload MP4 video files, and apply printer firmware and touchscreen 
(UI) updates. Backed-up print jobs can then be transferred (uploaded) to another QL-900 printer.

Note: Stored print jobs are jobs that have been saved to the printer's memory. See “Using Stored 
Jobs (Print Job Library)” on page 54.

Important: Do not connect any devices other than FAT32 formatted USB flash drives to the 
printer.

Overview: When a USB thumb drive is inserted into the control panel USB port, it is automatically 
detected and a USB management application opens on the touchscreen.

Select a range of functions via six buttons, depending on what is available on that USB drive.

Green outline: Active. White outline: inactive or display only.

Important: When finished backing up or uploading, press the Quit button and give the system a 
few seconds to correctly shut down the USB drive before removing it.

When a FAT32 formatted USB flash drive is plugged into the USB port [A], the USB Management 
screen opens.

USB Storage Device Detected: Displays the printer you are connected to, and the date and time.

USB: The graph displays the amount of usable memory left on the USB flash drive plugged into 
the printer.
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Backup Logs button: Backs up all the debug log files currently on the printer. There are two 
groups of logs. Each group is automatically backed up as a zip file located at the top level on the 
USB drive directory using the following format:

• Printer Logs: Model_SerialNumber_YYMMDDHHMM.tgz

• System Logs: Model_SerialNumber_YYMMDDHHMM_syslog.tgz

Log files can be opened/unzipped using a zip file utility.

Backup Print Jobs button: Backs up all the print jobs currently stored in the printer's Print Job 
Library onto the USB drive. They are stored in a directory using the following format:

• prns/Model_SerialNumber_YYMMDDHHMM/job_files

Under the main prns directory, the job files are the individual prns. There is also a directory of 
thumbnails associated with each job file.

Upload Print Jobs button: Allows you to copy and transfer print jobs between other QL-900 
printers.

During the upload, the printer model is checked against the saved jobs to ensure the job matches 
the printer. Invalid jobs are skipped and duplicate jobs are ignored. The USB drive's file format is 
the same as the Backup Print Jobs format. This means the job files should be contained in a 
directory located under a top level directory called prns. When Upload Print Jobs is selected, the 
list of directories below prns is displayed, allowing you to select which directory to import. All the 
valid files in the selected directory are imported.

Upload Videos button: Copy or transfer training or demonstration videos (MP4) to the printer. 
Before saving a video to the USB drive, create a directory on the top level of the USB drive named 
videos. DO NOT put videos in this folder.

Creating directory levels (folders) under the videos directory allows you to save a single video or 
groups of videos into that folder or folders. When Upload Videos is selected, the videos directory 
opens and displays the list of sub-folders where you have saved individual or groups of video files. 
You can now select which folder to import. All MP4 files in the selected folder are imported.

Note: This feature requires user interface (UI) firmware version 2.0 or higher.

Apply Updates button: Apply UI (*.rpz format) and firmware updates (*.fbf format) directly via the 
USB interface. When saving the UI and firmware updates to the USB drive, place them in a 
directory named updates at the top level of the USB drive. When the USB drive is plugged into the 
printer's control panel USB port, and the Apply Updates button is selected, the files are checked 
for compatibility. To avoid accidentally applying the wrong update, a confirmation screen helps to 
ensure the correct file is selected. Once an update has been applied, the UI will usually restart. 
After restarting, the USB drive will not be automatically detected. The USB drive needs to be 
manually removed and reinserted if more operations are required.

Note: This feature requires user interface (UI) firmware version 2.0 or higher.

Quit button: Press to exit the USB Management screen. Wait a few seconds for the printer to 
safely shut down the USB flash drive before removing it from the control panel USB port.
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Using the Printer Toolbox
Once the printer driver is installed, you can access the Printer Toolbox remotely from a computer. 
You can check printer status, monitor ink usage, perform diagnostic checks, print reports, and run 
maintenance tasks on the printer from your computer. The Printer Toolbox also has a more 
extensive list of functions not available on the touchscreen and password-protected access to a 
range of options for qualified service personnel.

To open the Printer Toolbox (from a computer):

Open Start Menu; then click on Toolbox, select QL-900.

[A] System status Indicator and drop-down menu options

[B] Check printer status

[C] Three often-used control buttons

Drop-Down Menu Options
There are four drop-down menus: View, Maintenance, Service, and Test Print. The drop-down 
menus are available on every Printer Toolbox screen, allowing you to toggle between menus and 
select different printer features and functions.
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View Drop-Down
The View drop-down gives you four choices: System Status, User Interface, Ink Usage, and 
Service Menus.
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System Status
This screen opens when you access the Toolbox. It provides information about the printer.

• Status Indicator shows printer activity as ONLINE, ERROR, MAINTENANCE, PRINTING, or 
PAUSED. The gray box below the Status Indicator shows the name of the job being 
processed.

• Page shows the page count for a given job.

• Job shows number of jobs printed (resettable). Session shows the total number of pages 
printed by the printer (resettable) over the length of a session (shift, day, week, etc.).

• Mid-Job counts down from a specified preset length of printed media until the next automatic 
printhead maintenance is performed by the service station.

Note: Select the length by opening the Printer Toolbox User Interface screen, Mid-Job 
Servicing. In this example, service is performed every 40 meters (131-ft.).

• Idle Timer shows in minutes how often maintenance will run when the printer is not running. 
Minutes are settable on the User Interface screen, Idle Timeout (min).

(Example: 9 = idle minutes elapsed. 360 = Preset number of minutes the printer must be idle 
before automatic maintenance is performed.)

• Wiper Transfer shows how often a wiper transfer (cleaning excess ink from the service station 
roller) will be performed in relation to when wipe printhead or printhead cleaning is performed. 
(Example: 3/1 = Printer performs 3 wipe printheads before one wiper transfer is performed.)

• Ink Levels displays the percentage of ink remaining in each of the ink tanks.

• Date and Time shows the current date and time. These can be configured and set by opening 
the Service drop-down screen, System Settings, Date and Time.

• Relative Humidity (RH) displays the current ambient humidity detected near the printer.

• Printer Messages may appear under RH (Relative Humidity).

• Media Icon: Displays the type of media the printer is currently configured for (continuous, die-
cut, or black mark). Set the type of media by selecting or tapping the icon and selecting the 
appropriate media type or using the Media Scan function after selecting Service Menus from 
the View drop-down menu.

• Printhead Height Icon: Shows current printhead printing height setting. (3 dots = Low, 
Normal, High settings) Set on the User Interface screen, Print Height.
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• Printer Icon: Shows status of the media sensors located in the media feed path of the printer. 
Also shows status of ink valves, service station, printhead and auxiliary devices (such as 
unwinders and winders). These can alert the operator to the type and location of a problem. 
Rolling over any of the status icons with your cursor opens a description of that icon.

• System Status: Displays the status of the printer and/or an error message.

Control Buttons (located along bottom of screen): Provide quick access to often-used functions.

• Pause/Resume: Tap to temporarily stop printing. Tap again to resume printing.

• Cancel Job: Cancels a paused job from the printing queue. Cancel is unavailable unless the 
Pause button has been pressed first. Canceled jobs must be reloaded before printing can 
resume.

• Clear Error: Click the button to clear error messages after you have resolved the printer 
problem (for example, after clearing a paper jam).
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User Interface
Adjust the printer for automated service and cleaning intervals, for specific types of media, and to 
set the feeder speed for a job.

• Mid-Job Servicing - Sets how frequently an automatic maintenance cycle is performed by 
selecting the length of printed media (in meters) that is run between cycles.

Minimum: 60m/197 ft.

Normal (Default): 40m/131 ft.

Maximum: 15m /49.25 ft.

Note: Mid-Job Servicing can only be set when the printer is stopped or paused.

• Invert Label Gap Sensor - Used with blackmark labels and the see-through media sensor. 
Checking the box reverses how the sensor normally reads the labels and gaps so lighter 
portions are read as labels, and the darker parts are read as gaps. This is useful if the 
reflective media sensor (normally activated with blackmark media) has trouble reading certain 
types of blackmark media.

• KWS Setting - (Keep Wet Spitting) Keeps the printhead hydrated while running a job.

Select from 4 settings: None, Light, Medium (default), and Heavy to determine how much ink 
will “spit” from the printhead nozzles. Set in conjunction with Mid-Job Servicing which 
determines frequency of printer stopping for self-servicing during a job.

• Interpage Frequency - On roll-to-cut jobs, set when the printer spits between labels (to keep 
the printhead nozzles hydrated and unclogged). For example: 3 = after every 3rd label; 5 = 
after every 5th label, etc.

• Idle Timeout (min) - Set in minutes how often idle maintenance will run when the printer is not 
running.

• Wipe Transfer Frequency - Set how often a wiper transfer (cleaning excess ink from the 
service station roller) will be performed in relation to when wipe printhead or printhead 
cleaning is performed.

Can be set from 0 (every time a wipe printhead is performed), or a set number such as 2 (after 
every second wipe printhead is performed).
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• Media Feed - Sets the printer sensors to read the type of media and/or the gaps between 
media when you select Continuous, Diecut, or Blackmark.

• Internal Print Job Cut - Checking this box allows you to print and cut one of the reports or test 
pages listed in the Print drop-down menu.

• Print Height - Set the height of the printhead to adjust for printing on different media 
thicknesses. Select one of three settings: High, Normal, and Low. An indicator appears on the 
Status Toolbox screen and touchscreen.

• Print and Present - Checking the box sets the printer to print one label at a time and push it 
out to the cutting position. This is useful for certain types of “as needed” printing.

• Click Submit to apply settings.

Display Language
Select the language the Toolbox and touchscreen will display. Click Submit after selecting 
language.

Firmware Download
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You can find and load the latest firmware (".fbf") files for your printer using the Printer Toolbox.

Warning: This procedure should only be performed by qualified service personnel. If this process 
is not performed properly, the printer is rendered inoperable.

Note: Printer firmware can also be applied using a USB flash drive and the control panel USB 
Port. See “Using the Control Panel USB Port” on page 67.

Update User Interface
Download and install the latest user interface UI (".rpz") file for the printer touchscreen.

Note: Updating this file does not require shutting down or restarting the printer.

Note: User interface (UI) firmware can also be applied using a USB flash drive and the control 
panel USB port. See “Using the Control Panel USB Port” on page 67.
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Ink Usage
Displays the amount of ink used and other information about each job sent to the printer. Also 
tracks estimated page and job costs if information is entered in the Job Cost Settings.

• Ink Estimation Mode - Lets you predetermine how much ink a given job may use prior to 
printing a job. This is useful for determining per-piece costs. The job is sent to the printer and 
loads but does not print. Once a job is loaded, click Refresh to show the amount of ink (by 
color) that job will use.

• Upload Table - Creates and opens a linkable tabular data file using programs such as 
Microsoft Excel. Microsoft Excel is the default.

• Mode selection:

Off - Feature is disabled.

Continuous - Ink Estimation Mode continues running (printer will not print), until the feature is 
turned OFF.

• Single Pass - Ink Estimation Mode runs once, then turns off. The printer will then be ready to 
print.

Click Submit to activate the mode setting selected.

Note: The estimating process takes as long as the job would take to print. For example, if a job 
would take one hour to print, the estimate will take one hour to display. Track progress on the 
Counter located in the System Status window.
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• Reset Page Counter - Tap or click this button to reset the printer page count to 0. (Page on 
the Printer Toolbox and touchscreen.)

Job Cost Settings

Enter your Ink Tank Cost, Printhead Cost, and Media Size preference (inches or mm). Set a 
minimum of at least 100 pcs. to ensure a large enough sample size. Click Submit. In Ink 
Estimation Mode, this feature estimates per-page cost and job cost without printing the job 
(note that there are columns providing results at both single-page and 1000-page levels). With 
Ink Estimation Mode disabled, the printer still tracks the estimated per-page cost and 
estimated job cost as the job is being printed. Once the costs are entered, they will remain until 
changed again, even if the printer is turned OFF.

Note: This is only an estimate and does not include other factors that may affect the overall 
result.

Service Menus
Clicking Service Menus opens the Service Menus (Diagnostics) screen and service menu 
buttons.

Diagnostics

Click to check the status of the printer. See “Diagnostics” on page 78.

System Settings

Click to view, enter, or change settings to connect the printer to your network. Also configure 
and set the printer's date and time. And set the level of detail desired for debug logs.

Debug Logs

Click to display a list of available debug logs that can be opened or uploaded. Then select the 
log or logs to be uploaded.



Operating the Printer

QL-900 User Guide 78

Media Scan

Use Media Scan to fine tune sensor sensitivity and/or adjust scan length if media is not 
printing correctly, or to determine if a type of media is going to have problems printing. This is 
generally due to the sensors having trouble differentiating between the label surface and 
backing/gap. See “Media Scan” on page 83.

Scan Sensors

Provides status and a log of sensor activity on the sensors located throughout the printer. See 
“Scan Sensors” on page 85.

Service Menus

Entering the Service Menu password provides access to more advanced printer control and 
maintenance menus. For authorized service personnel only.

Diagnostics
This is the screen that opens when you select Service Menus. From this screen you can see 
status of the printer.
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Upload Debug Log

Upload and save a log of the printer status to send to a technician to help diagnose a problem. 
Clicking this button creates a snapshot log showing everything going on with the printer since 
powering up.

Note: If a problem arises, try to recreate the problem. Then press the Upload Debug Log 
button without performing any other actions. This may make it easier for the technician to 
determine the problem. If this is not possible, include any actions you may have taken after the 
problem began.

Event Log History

Displays significant events occurring on the printer (such as firmware updates, errors, power 
off, etc.) This log is useful for troubleshooting printer problems.

NVM Settings

Displays the printer's current NVM (Non-Volatile Memory) settings. Once settings are saved, 
they remain even when the printer is turned off, until they are manually changed.

VARS Settings

Displays the printer's current VARs (Variable) settings. Settings that are set for a job that 
automatically revert to the default settings when the printer is turned off or restarted.



Operating the Printer

QL-900 User Guide 80

System Settings
Set up a network connection for the printer. You can also configure and set the printer Date and 
Time, set the Debug Log Level, and set the Screensaver Timeout (sleep delay).

Network Settings

Permits you to view, enter, or change settings to connect the printer to your network.

Network Connection Set-Up

Printer is still connected to the computer via the USB cable. To connect the printer to a 
network: From the Toolbox, select View drop-down menu, click Service Menus, then click 
System Settings.

System Settings screen opens. Use Network Settings to enter the correct settings for your 
network.

Note: If manually changing the ip_address, make sure the “dhcp” and “autoip” boxes are 
unchecked. (Default is checked.) Enter changes in the appropriate boxes. Click Submit.

Connect the Ethernet cable to the network port on the rear panel of the printer.
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Date and Time

Enter or change the way the date and time will appear in the Printer Status section of the 
Toolbox screens.

From the Toolbox, select View drop-down menu, click Service Menus, and then click System 
Settings.

System Settings page opens. Use Date and Time options to enter, edit, and format the date 
and time for the printer.

Click Submit.

Debug Level

Set the detail level of the Debug Logs.

From the Toolbox, select View drop-down menu, click Service Menus, and then click System 
Settings.

System Settings page opens. Go to Debug Level options and select 0, 1, or 2 to set the 
desired detail level for the Debug Log. (0 = least detailed, 2 = most detailed).

Note: Because of the amount of data collected and stored, it is recommended that you not set 
the Debug Level over 1 unless asked by a service technician.

Click Submit.
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Screensaver

Set the amount of time the touchscreen will remain idle before automatically going to Sleep 
Mode.

From the Toolbox, select View drop-down menu, click Service Menus, and then click System 
Settings.

System Settings page opens. Go to Screensaver. Enter the number of seconds the 
touchscreen will remain idle before going to Sleep Mode.

Click Submit.

Debug Logs
Access, print, or send activity logs for the printer and for jobs run on the printer. These files are 
valuable for diagnosing and servicing problems.

From the Toolbox, select the View drop-down menu, click Service Menus, and then click Debug 
Logs.

• All - Shows all log files available.

• Debug - Shows only debug log files.

• Jobs - Shows only jobs printed log files.

• Delete All - Deletes all debug and jobs log files.

• Recycle symbol - Deletes the selected file.
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Media Scan
Use Media Scan to fine tune sensor sensitivity and/or adjust scan length if the media is not 
printing correctly, or to determine if a type of media is going to have problems printing. This is 
generally due to the sensors having trouble differentiating between the label surface and backing/
gap.

Note: If using notched tags, open the top cover and slide the white magnetic strip [A] back to 
uncover the See-Thru Sensor [B]. Cover the sensor for all other media.

Media Scan Procedure
1. Load media in the printer as if printing a job.
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2. From the Toolbox, select the View drop-down menu, click Service Menus. Click Media Scan.

3. Under Media Scan Setup, set Scan Length:

The media length for the scan is in millimeters. Set a length at least 4-5 labels long.

4. Set Media Feed: Select what type of media is being fed; Continuous, Diecut or Blackmark.

5. For Diecut or Blackmark media, (some or all sensors may be inactive for specific types of 
media), set Sensor sensitivity:

For Diecut:
Set Diecut Power
Set Diecut Sensitivity

For Blackmark:
Set Blackmark Power
Set Blackmark Sensitivity
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6. Click Submit to enter your selections. Then click the Scan Media button. Blank media moves 
across the sensors to create the graph shown on the screen.

Note: Tapping or rolling the cursor over the blue graph line provides readouts of the points on 
the graph.

Legend: Explains what the graph is showing.

Media (TOF/BOF-Green line). Sensor (Sensor-Blue line).

Edge Distances: Top line shows the average gap distance reading in millimeters.

Bottom line shows the length of the label reading in millimeters.

7. If the graph and/or results require adjusting, you can increase or decrease the sensor 
sensitivity by changing the sensor sensitivity values. You can also increase or decrease the 
length of media to be scanned by moving the slider on the Scan Length bar. Press the Scan 
Media button again to obtain a new result.

Note: Make sure that the label type and the Toolbox Media Feed type icon match. Only the 
sensors for that type of media will be active. If the label type is different, an Error will show in 
the System Status box.

Note: Media Scan is also available on the printer touchscreen.

Scan Sensors
Provides status updates and an activity log on the sensors located throughout the printer. Provides 
useful details for service personnel. (See chart below.) Click the Stop button to stop scanning or 
click out of Scan Sensors.
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Maintenance Drop-Down
Perform maintenance tasks on the printer.

Circulate Ink

Purges air from the lines and primes the system after replacing the ink tanks or printhead 
cartridge.

Full Clean Printhead

Runs the cleaning routine multiple times for the most thorough flushing and cleaning of the 
printhead.

Normal Clean Printhead

Runs the cleaning and wiping routine twice for a more thorough flushing and cleaning than 
Quick Clean.

Quick Clean Printhead

Circulates ink; wipes and cleans the printhead cartridge.

Inspect Sled

Moves the service station out for inspection, cleaning, or service.

End Inspection

Moves the service station back into position under the printhead.

Wiper Transfer

Squeegees excess ink off the service station wiper roller.
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Service Drop-Down
Control functions that require the printer to be out of service for extended periods of time while 
they are being performed.

System Deprime

Pumps ink back into the ink tanks prior to replacing the printhead cartridge or transporting the 
printer.

Shutdown

Turns the printer OFF. For best system performance, it is recommended to keep the print 
engine powered-up (ON/OFF light illuminated) at all times. If turning the printer off, first power-
down the print engine using the Shutdown button in Toolbox or the ON/OFF button on the 
control panel. Wait until the touchscreen turns off before turning off the main power switch.

Restart

Restarts the printer without having to perform the startup routine (purging ink tanks, priming, 
etc.).

Restart UI

Restarts the printer touchscreen without having to perform the printer startup routine (purging 
ink tanks, priming, etc.).

Test Print Drop-Down
Print various reports and printer tests. Each printout displays information about the printer.

Print Setup Page

Prints a printing pattern used for positioning the image on the page.



Operating the Printer

QL-900 User Guide 88

Print Configuration

Prints the current printer configuration including firmware version, network connection, printer 
serial number, and more.

Print Printhead Test

Prints color bands, text, and patterns to check the condition of the printhead's ink nozzles. 
Note that this uses less ink than Print Color Bars.

Print Color Bars

Prints a series of 7 color bars (per printhead) to indicate how well the printhead is mixing 
colors and printing.
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Chapter 4: Maintenance

Periodic maintenance is needed to keep the printer in good working order. This section covers how 
to care for the ink tanks, printhead cartridge, and service station. It also covers how to clear paper 
jams.

Replace Ink Tanks
Replace the ink tanks when the ink runs out.

1. Look at the control panel touchscreen. Ink tank status information appears on the right side of 
the touchscreen. Note that some or all ink tank indicators may be low or empty.

Caution: Verify that the labels on the ink cartridge and the printer’s ink station match. Both 
should be “DN”.

2. Open the ink tank door (hinged at the bottom). Opening the door disconnects the printer 
communication from the ink tanks and allows safe installation and replacement.

Open ink tank latches [A].

3. Remove the new ink tanks from the packaging.
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4. Insert the ink tanks (labels up) into the appropriate color slots [B]. Close the ink tank latches.

Note: Make sure the ink tanks seat properly. Insert the ink tank into the appropriate ink station. 
Pull the ink tank back about an inch and then push forward firmly to ensure that the ink nozzles 
penetrate the seals on the ink tanks.

5. Close the ink tank door. Ink colors fill in as the ink tanks are installed. If the ink colors do not fill 
in after a few seconds, open the ink tank door again and reinstall the ink tanks.

6. When the printer stops processing and no errors appear on the System Status screen, the 
printer is ready for use.

Warning: Ink in ink tanks may be harmful if swallowed. Keep new and used ink tanks out of 
the reach of children. Discard empty tanks immediately.

Clean Ink Tank Contacts
When reinstalling or replacing the ink tanks, the ink level indicators on the touchscreen may not 
refresh. This may be due to a dirty ink tank level prism and/or QA chip contacts on that ink tank. 
Clean contacts as follows:

1. Remove the ink tanks. Open the ink tank door. Release the ink tank latches [A]. Remove the 
ink tanks [B] that did not refresh.
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2. Clean the ink level prism [A] and QA chip contacts [B] with a clean, dry, lint-free cloth.

Note: Dampen the cloth with distilled water to wipe the prism, but DO NOT get the QA chip 
contacts wet.

3. Reinstall the ink tanks (labels up). Close the ink tank latches. Close the ink tank door.

Storage
New ink tanks should be stored in the original packaging and kept away from heat.

Opened ink tanks should remain in the printer.

Nominal ink expiration date: 24 months following date of manufacture (ink fill date).

Disposal
Safely dispose of the ink and ink tanks in accordance with local/national regulations.

Clean up spills with soap and water. Abrasive soap is effective in cleaning ink off your hands.
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Clean/Replace the Printhead Cartridge

Cleaning
The printhead is cleaned automatically each time the printer is turned on or when the Quick Clean 
Printhead routine is performed. This can be found under Service Tab, Normal Clean Printhead 
in the printer driver or Maintenance drop-down menu on the touchscreen. If running automated 
cleaning levels doesn't help improve print quality, the printhead cartridge can be cleaned manually.

1. From the touchscreen, tap Setup in the Menu drop-down, then tap System Deprime. The 
printer pumps any ink in the system back into the ink tanks. Then the printhead latch opens.

Caution: Do not pry or manually lift the printhead latch or the latch may break. Only open the 
latch using the release printhead button on the touchscreen or in the printer toolbox.

2. Open the top cover. Make sure the printhead latch is fully opened to retract the ink lines. 
Remove the used printhead cartridge by tilting it toward the ink lines, then carefully lifting it out 
of the printhead compartment.



Maintenance

QL-900 User Guide 93

3. Moisten the printhead nozzles using deionized/distilled water (reference ASTM D5127-90 
Type E-II Electronic Grade Water) and a damp, lint-free cloth. Wipe the printhead nozzles end 
to end. (Gray strip located below orange strip.)

Take care not to damage the copper contacts, metal plate, or printhead surface.

4. Reinstall the printhead, close the printhead latch, and close the top cover.

Generally, when the ink supply is adequate and the print quality remains poor, or when automated 
cleaning processes or manually cleaning the printhead does not help the image quality, replace 
the printhead.

Caution: Use electrostatic discharge (ESD) protection when handling.

Caution: Hold the printhead cartridge by the handles ONLY.

Caution: DO NOT touch the ink couplings, nozzle surface, or electrical contacts.

Caution: DO NOT unpack the printhead cartridge until the printer is ready for installation. Once 
unwrapped, delay in installing the printhead can compromise print quality due to dehydration.

Caution: DO NOT place an unwrapped printhead on any surface before installing. Protect the 
printhead from scratches, dust, fibers, dirt, and other contaminants at all times.
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Replace the Printhead Cartridge
Important: To ensure optimum printing performance, inspect and replace the wiper roller as 
necessary when replacing the printhead.

1. From the touchscreen, tap Setup in the Menu drop-down, then tap System Deprime. The 
printer pumps any ink in the system back into the ink tanks. Then the printhead latch opens.

Caution: Do not pry or manually lift the printhead latch or the latch may break. Only open the 
latch using the release printhead button on the touchscreen or in the printer toolbox.

2. Open the top cover. Make sure the printhead latch is fully opened to retract the ink lines. 
Remove the used printhead cartridge by tilting it toward the ink lines, then carefully lifting it out 
of the printhead compartment.
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3. [A] Carefully remove the printhead cartridge from the foil packaging. Tear the foil at the notch 
or cut the end with scissors.

[B] Remove the protective plastic cover. Hold the printhead by its handle and unclip the cover 
from the printhead.

[C] Remove the protective strip from the printhead electrical contacts. Once removed, DO 
NOT allow the strip to touch the electrical contacts.

[D] Remove the protective strip from the printhead nozzles. Hold the printhead by the handle. 
Pull the strip tab and slowly peel the strip from the printhead.

DO NOT pull the strip at less than a 45° angle from the printhead surface.

DO NOT allow the removed strip to touch the printhead nozzles.

Note: Keep foil packaging to store/dispose of old printhead cartridge.
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4. Wet the printhead surface to ensure that the printhead will prime correctly. Moisten the 
printhead nozzles using distilled water and a damp, lint-free cloth, wiping end to end. (Gray 
strip located below the orange strip.) Take care not to damage the copper contacts, metal 
plate, or gold printhead surface.

5. Carefully insert the cartridge into the compartment at an angle [4], with the printhead surface 
facing down and the ink nozzles facing the ink hoses. Once the cartridge is seated, gently tilt it 
back until it snaps into an upright position [5]. DO NOT FORCE cartridge into position.
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6. Close the printhead latch [6]. Close the top cover. The printer starts up and primes ink into the 
printhead (this may take a few minutes).

Note: When priming stops, open the top cover and check that ink is flowing through the hoses. 
If air bubbles appear, tap the lines and close the top cover. Or close the top cover and click 
Circulate Ink on the touchscreen to clear the air bubbles.

7. Watch the control panel touchscreen. Check that the printhead icon [7] in the printer image is 
primed (solid color).

8. When ONLINE [8] appears, the printer is ready for use.

If the printhead icon continues to display an outline or a question mark (?), try the following 
procedures:

• Printhead icon shows an outline (printhead unprimed): Click Circulate Ink under the 
Maintenance drop-down menu in the printer Toolbox. If the issue persists, try the Install 
Printhead procedure again. If this does not resolve the issue, contact technical support.

• Printhead icon displays a question mark (printhead not recognized): Try the Install 
Printhead procedure again. If the issue continues, contact technical support.

Note: The printer may take up to 12 minutes to set itself up during initial startup. This is normal.

Important: Check ink tanks. The printer may not fully reprime if the ink tanks are less than 1/3 full.
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Printhead Storage
Store and transport the cartridge as indicated by the “this side up” arrow symbol on the packaging.

The cartridge and ink supply must be within the operating temperature range before attempting to 
prime the cartridge with ink and starting to print. When stored at temperatures below the operating 
range, it may take up to 3 hours for a cartridge in its packaging to reach operating temperature.

Note: Additional packaging will increase the time needed to reach operating temperature.

Storage Specifications

Storage Life 12 months from date of manufacture (printed on shipping 
box).

Storage Temperature Range Long Term: 14° F to 86° F (-10° C to 30° C)
Short Term: -11° F to 140° F (-25° C to 60° C)

Cumulative storage duration above 86° F (30° C) must not 
exceed 72 hours.

Humidity Range 5% to 95% Relative Humidity, non-condensing

Atmospheric Pressure Range 70 kPa to 106 kPa

Electrostatic Discharge 8 kV air discharges or 4 kV contact discharges*

*When tested in accordance with IEC 61000-4-2
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Inspect the Service Station
The service station (located directly under the printhead assembly) cleans the printhead cartridge 
of excess ink and debris, keeps the printhead hydrated and protected when not in use, and 
removes ink used to keep the nozzles clear. It moves out of the way of the printhead during 
printing. It is designed to provide a long service life.

1. Using the touchscreen, select Menu, then tap Maintenance from the drop-down menu. Tap 
Inspect Sled. The service station [A] moves out from under the printhead assembly.

2. Open the top cover.

3. Visually inspect the service station for cleaning or service.

Use a dry, lint-free cloth to soak up any excess ink from the cap station [B].
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4. Tap End Inspection on the touchscreen to move the service station back under the printhead 
assembly.

5. Close the top cover.

Replace the Ink Waste Tray
The ink waste tray soaks up any excess ink that may drip from the print engine during operation.

After a period of time it may become saturated and need replacement.

1. Open the ink tank door.

2. Push in on the tabs [A] to release the ink waste tray and remove it from unit.

3. Replace it with the new ink waste tray [B].
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Jams in the Printer
Clearing a jam depends on where the jam occurred.

Print Area:

• Open the ink tank door.

• Pull the clamshell latch [A] toward you to unlatch the clamshell.

• Raise the clamshell [B].

• Clear the jam, then carefully lower the clamshell.

Caution: Do not allow the clamshell to drop or slam closed.

Misfeeds
To correct misfeeds:

• Roll Feed - Unwinder/Winder may be moving too fast or slow for the job being printed. 
Readjust speed controls on the unwinder and winder.

• Fanfold - Straighten the stack.

Cleaning
Warning: The printer is a precision machine. Clean it regularly to ensure many years of service. 
Before performing any maintenance, disconnect the machine from its power source.

Warning: Do not remove side covers! High voltages present.

Clean the printer regularly to remove accumulated paper dust and ink. Depending on the types of 
media run, paper dust may accumulate inside the printer and on the transport.

1. Turn the printer OFF and unplug it from the power receptacle. Then open or remove the 
covers.

2. Interior: Use a vacuum with a soft brush attachment or a can of compressed air to help loosen 
dust particles.

Note: Be careful around the ink tray and capping station in the print engine area as 
accumulated ink may splash onto other parts of the printer. Take care not to damage the PC 
boards or electrical wiring.
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3. Exterior: Wipe clean with a lint-free cloth using any standard nonabrasive household cleaner 
that does not contain plastic-harming solvents.

Caution: Never spray or pour cleaners directly on or into the printer. Excess liquid could harm 
electronic parts. Dampen a lint-free cloth with the cleaner and apply it to parts to be cleaned.

Feed Rollers and Forwarding Rollers
Feed, forwarding, and transport rollers can become glazed with paper lint and ink from the media. 
Clean them regularly with a mild abrasive household cleaner on a damp lint-free cloth.

Note: Avoid using solvents on rubber rollers.

Print Engine
Areas in the print engine can become glazed with a buildup of dust, paper lint, and accumulated 
ink. These areas must cleaned regularly. Open the top cover. Open the clamshell assembly by 
releasing two latches. Use a vacuum to pick up any loose debris.

Note: Be careful around the ink tray and capping station in the print engine area as accumulated 
ink may splash onto other parts of the printer. Take care not to damage the PC boards or electrical 
wiring.

Caution: Use only deionized/distilled water to clean the print engine components. Avoid 
contaminating the printhead with cleaners, lubricants, or other chemicals.

[A] Media Sensors: Paper lint and dust may build up on the media sensors. Use a can of 
compressed air or a damp (not wet) foam or lint-free cotton swab to gently swab the sensors. Take 
care not to drip water into the circuit boards. Use a clean, dry swab to dab surfaces dry.
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[B] Rubber Rollers: Clean as needed using distilled water with a damp, lint-free cloth. Be careful 
not to splash or drip ink on other parts of the printer.

[C] Printing Surfaces, Ink Drip Cover, and Tray: Wipe using distilled water and a damp, lint-free 
cloth. Pat dry with a lint-free cloth.

Ink Drip Tray: Carefully remove the ink drip tray cover and ink drip tray. DO NOT tip the tray or ink 
may spill. Wipe off excess ink. Then clean using distilled water and a damp, lint-free cloth.

Clean Ink Revolver Couplings
1. First, deprime the system and remove the printhead cartridge.

2. Moisten a foam swab in distilled water.

3. Insert the swab into one of the ink channels and rotate the swab to clean the chamber.

4. Use a new swab for each of the remaining ink channels until all 10 openings are clean (5 on 
each side).

Shipping or Transporting Printer
If you must ship or transport the printer for any reason, the unit will have to be prepared. Once the 
printer is prepared, carefully package the printer, printhead cartridge, service station, and ink tanks 
in the original packaging.
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Remove the Printhead Cartridge
1. From the touchscreen, tap Setup in the Menu drop-down. Then tap System Deprime. The 

printer pumps any ink in the system back into the ink tanks. Then the printhead latch opens.

Caution: Do not pry or manually lift the printhead latch or the latch may break. Only open the 
latch using the release printhead button on the touchscreen or in the printer toolbox.

2. Open the top cover. Make sure the printhead latch is fully opened to retract the ink lines. 
Remove the used printhead cartridge by tilting it toward the ink lines, then carefully lifting it out 
of the printhead compartment.

3. Pack the printhead cartridge area with absorbent towels to catch any ink drips or spills. 
Carefully pack the cartridge using the original packaging.

Empty and Clean the Ink Drip Tray
1. Open the clamshell.
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2. Carefully lift the two tabs out of the slots in the print engine frame and remove the ink drip tray 
assembly [A]. DO NOT tip the tray or ink may spill. Empty the tray if necessary and wipe off 
excess ink. Clean using distilled water and a damp, lint-free cloth.

3. Reinstall the ink drip tray assembly.

Turn the Printer Power Off
Caution: When powering down the unit, always use the following steps.

1. Press the power button on the control panel.

2. Wait for the printer to stop processing.

3. Then press the main power switch on the rear panel.

Remove Ink Tanks
1. After depriming the system, open the front cover (hinged at the bottom). Open the ink tank 

latches [A] and pull the ink tanks [B] out of the printer.
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2. Carefully package the ink tanks in the original packaging.

Important: Make sure the ink seals on the ink tanks face up to prevent leakage.

3. Pack the ink tank bays with absorbent towels to catch any ink drips or spills.

Printer Maintenance Schedule
General, periodic maintenance is needed to keep the printer in good working order. Many tasks 
can be performed by operators with basic supplies, and no special tools are needed. Other tasks 
should only be performed by trained service personnel.

Note: High volume usage may require more frequent maintenance.

Maintenance Supplies & Equipment
Flashlight, small telescoping mirror, hard-bristled toothbrush or equivalent, powder-free nitrile 
gloves, protective clothing and eyewear, small flathead screwdriver, tweezers, vacuum with wand, 
deionized distilled water, can of compressed air, foam or lint-free cotton swabs, lint-free wipes, and 
disposable shop towels.
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Schedule

Warning: Always power down the printer before connecting or disconnecting any wiring 
harnesses or cable connections to avoid serious shock or injury.

Caution: Always use appropriate personal protection equipment (PPE).

Caution: Use electrostatic discharge (ESD) protection when maintaining equipment.

Caution: Dispose of all maintenance waste in accordance with local regulations.

Components/Tasks
Maintenance Tasks

Daily Bi-Weekly Monthly Yearly As Needed

Performed by Operator

Printhead (Manual Wiping) Wipe

Ink Revolver Couplings and 
Connections: Inspection/
Cleaning

Every 
Printhead 
Removal

Residue and Debris 
Removal

Clean Clean Clean Clean Clean

Optical Sensors (Media 
Path)

Clean Clean Clean

Wiper Assembly: Inspection Inspect Inspect Inspect

Ink Tank Latches/Ink Bay Inspect

Ink Tubing, Couplings, 
Components

Inspect Inspect

Ink Drip Tray Clean weekly or as needed

Ink Waste Tray Inspect Inspect Replace

Printhead Lift Motor Belts 
and Service Station Belts

Inspect Inspect

Performed by Service Technician

Lubrication Apply Apply

Pen Driver PCA Contacts: 
Cleaning

Every 
Printhead 
Removal

Moving Parts/Motor Test

Service Station Sled 
Assembly

Clean

Wiper Assembly: Cleaning Clean
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Chapter 5: Troubleshooting

This information is provided to assist in solving any problems that might occur with the printer. 
Make sure that the system is set up properly, plugged in, and has an adequate supply of ink before 
attempting to troubleshoot any problem.

Printhead

Condition Problem Solution

Missing parts of letters or text. Air and bubbles blocking nozzles. Clean printhead using recirculation, 
priming, or cycles of depriming and 
priming found on the printer 
touchscreen or in the Printer 
Toolbox.

Rehydrate the printhead using 
distilled water and a wet, clean, 
lint-free cloth.

Air bubbles often disappear with 
printer use.

Print shows regularly missing or 
misdirected nozzles or ink color 
mixing.

Debris on printhead. Perform startup routine.

Clean the printhead using a 
cleaning level on the printer 
touchscreen or in the Printer 
Toolbox.

Wipe the printhead manually with 
distilled water and a wet, clean, 
lint-free cloth.

Replace the printhead.

Ink mixing - Mixed or muddy colors. Ink flooding, air in printhead, or a 
dirty printhead.

Clean the printhead using a 
cleaning level on the printer 
touchscreen or in the Printer 
Toolbox.

Wipe the printhead manually with 
distilled water and a wet, clean, 
lint-free cloth.

No print or crisp blocks of missing 
drops.

Electrical failure or poor electrical 
connection.

Reseat the printhead.
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Warning: Do not remove the side covers of the printer! High voltages are present behind the 
covers!

Printer

System will not reprime ink after 
replacing the printhead cartridge.

Printhead nozzles are dry. Wipe the printhead manually with 
distilled water and a wet, clean, 
lint-free cloth.

Ink tanks may be 1/3 full or less. Replace ink tanks.

Condition Problem Solution

Condition Problem Solution

Ink tank installed, no ink level 
indication in Toolbox

Ink tank contacts are dirty, 
preventing printer/ink tank 
communication.

Remove ink tank(s).

Clean prism and QA chip contacts. 
See “Clean Ink Tank Contacts” on 
page 90.

Extra lines; losing data Database problem. Check data in database program.

Improper output (address 
information out of order, 
misfeeding, etc.)

Wrong interface settings. Check software or database on 
PC.

Static electricity. Close software, then turn printer 
OFF and ON.

Dirty media sensor. Clean media sensor.

Media jams Misfeeds.

Media is curled or bent.

Media is too thin.

Label Rolls: Adjust unwinder/
winder speed.

Fanfold Labels: Check if labels are 
stuck together.

Uncurl media.

Minimum thickness for media is 
0.004".

No communication Improper cabling / connector. Use a proper USB cable.

Unit not receiving power. Check plug connections, ON/OFF 
button, and fuse on back panel.

Print too light or missing character 
dots

Clogged or dirty printhead. Check the printhead.

Running out of ink. Check the ink tanks.
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Errors and Warnings

Printer Alert Window Messages
Messages sent from the driver are displayed on the PC screen in a small popup window.

Blurry address Image is not sharp. Clean the printhead using a 
cleaning level on the printer 
touchscreen or in the Printer 
Toolbox.

Clean the printhead manually using 
distilled water and a wet, clean, 
lint-free cloth.

Feeding problems Misfeeds. Label Rolls: Adjust unwinder/
winder speed.

Fanfold Labels: Check if labels are 
stuck together.

Check if labels are sticking 
together.

Job is sent to print but does not 
print.

Printer not turned ON. Check that the printer is ON.

Printer not connected to computer. Connect printer cable to computer 
and resend job.

Media sensor is covered in print 
engine.

Open print engine and remove 
media.

Condition Problem Solution

Message Solution

Cleaning in Progress Wait until the message disappears. The printer will start 
printing your job once the cleaning process is complete.

Excessive Tilt Error See “Toolbox System Status Messages” on page 112.

Incompatible Printhead Remove and reinsert your printhead cartridge. Replace 
the printhead.

Incorrect … Ink Tank Replace the ink tank.

…. Ink Low

Example: Black Ink Low

Reorder ink.

…. Out of Ink

Example: Cyan Ink Out

Replace empty ink tank.

Load Paper Out of paper. Load media into the printer and press the 
PAUSE/RESUME button to resume printing.
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Mechanical Jam Check for and remove obstruction, then press PAUSE/
RESUME button to resume printing.

Check/Clean sensors. If the problem persists, contact 
technical support.

Missing Printhead Remove the printhead cartridge. Check/Clean electrical 
contacts. Reinsert the printhead. Replace the printhead. If 
the problem persists, contact technical support.

Multiple Inks Low Reorder ink.

Multiple Ink Tanks Out Replace empty ink tanks.

Multiple Ink Tanks are missing Insert missing ink tanks.

Clean electrical contacts and reseat ink tanks.

Multiple Unauthorized Ink Tanks Remove and reinsert the ink tank. Replace the ink tank.

Paper Jam Remove jammed media. Check for proper feed setup then 
press the PAUSE/RESUME button to resume printing.

Check/Clean the sensors. If the problem persists, contact 
technical support.

Printhead Latch Open Ensure that the printhead cartridge is inserted properly, 
then close the printhead latch so that it locks.

Print Zone Assembly (Clamshell) 
Open

Check to be sure the clamshell is completely closed and 
latched.

The … Ink Tank is missing Insert the missing ink tank.

Clean electrical contacts and reseat the ink tank.

Unauthorized … Ink Tank 
Installed

Replace the ink tank.

Unauthorized Printhead Replace the printhead cartridge.

Message Solution
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Toolbox System Status Messages
Use the touchscreen or Toolbox screen to quickly determine and locate a problem in the printer.

The status indicator shows ERROR in a red box. The printer graphic icon highlights the printer and 
system affected. The system status information displays the basic problem (in red). Ink levels 
display the ink status. Control buttons (at the screen bottom) let you perform often-used tasks 
without leaving the screen.

Listed below are some of the messages that may appear in the system status.

System Status Source Solution

PAPERPATH_END_OF_ROLL Out of media. Load a new roll of media into the 
printer. Tap the Clear Error button 
and then tap the Pause/Resume 
button on the Job screen to resume 
printing.

Unwinder label tension arm has hit 
its upper or lower limit.

Verify that the unwinder is threaded 
correctly and the speed is set 
correctly.

The end of the media did not 
release from the roll core. The tape 
is too strong.

Try to use stock that has soft-
release tape holding the media to 
the cardboard core.



Troubleshooting

QL-900 User Guide 113

PAPERPATH_PAPERJAM

Depending on where the media 
stops/jams, it is also possible for 
the printer to display:

PAPERPATH_FEED_TIMEOUT

Media jam detected.

The printer has detected that one 
(or more) media sensors are 
blocked (interrupted).

Carefully remove jammed media 
from the printer and close the print 
engine. System status message in 
red should go away.

Touchscreen and Toolbox 
Paperpath Sensor indicators 
should change from red to green.

After jam is cleared, you can:

Label Rolls: Adjust unwinder/
winder speed.

Fanfold Labels: Check if labels are 
stuck together.

Uncurl media.

Tap the Clear Error button and then 
tap the Pause/Resume button on 
the Job screen to resume printing.

MAINTENANCE_BUSY Machine is performing a 
maintenance procedure.

No action required. Wait for the 
printer to finish.

DOOROPEN_PRINTHEAD Indicates that the printhead door is 
open.

Verify that the printhead door is 
closed. Make sure that the 
printhead door switch (located at 
the back center of the door) is 
activated when the printhead door 
is open and closed.

Switch damaged or disconnected. Use Scan Sensors in the Printer 
Toolbox to check that the printhead 
door switch is functioning.

DOOROPEN_INK Indicates that ink tank door is open. Verify that the ink tank door is 
closed. Make sure that the ink tank 
door switch (located at the upper 
right corner of the door) is activated 
when the ink tank door is open and 
closed.

Switch damaged or disconnected. Use Scan Sensors in the Printer 
Toolbox to check that the ink tank 
door switch is functioning.

System Status Source Solution
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DATA_PATH_UNDERRUN Media is not moving from the entry 
sensor to the exit sensor within a 
specified time.

Possible issue with format or 
orientation of job being sent.

Dirty encoder wheel.

Check/Clean the media transport 
rollers. Check/Clean the sensors 
and reflector.

Try changing the orientation setting 
in software/driver or setting a 
different media size.

If the problem persists, contact 
technical support. They should 
check/clean the encoder wheel.

INK_LOW_X One or more ink tanks are low on 
ink.

X = Color.

MULT = More than one tank color.

Ink tank replacement will be 
necessary soon. Reorder ink.

INK_OUT_YELLOW One or more ink tanks are out of 
ink.

X = Color.

MULT = More than one tank color.

“Out” = System calculated that 
250ml of ink was drawn from the 
tank or visible ink sensor sees no 
ink in tank prism.

Open the ink tank door. Replace 
empty ink tank(s).

Verify that ink tanks are seated 
firmly and latches are fully closed.

Close the ink tank door and tap the 
Clear Error button. The ink levels 
should fill in.

Note: A premature visible ink “Out” 
condition can occur if the printer is 
not on a sturdy, level surface.

CARTRIDGE_MISSING_MULT

or

CARTRIDGE_MISSING_X

Ink tank is missing or not 
recognized (obtained from an 
unauthorized reseller).

X = color (C M Y K1 K2)

MULT = more than one tank color.

Insert the missing ink tank or move 
ink tank in and out to improve the 
connection. Check/clean the ink 
tank contacts.

Tap the Clear Error button and then 
tap Pause/Resume button on the 
Job screen to resume printing.

MECH_FAIL_PERMANENT

ERROR on System Status screen.

Check the Printer Graphic to 
determine which component has a 
problem or failed: Service Station, 
Ink Valve, or Printhead (usually 
indicated with a steady ?)

Mechanical error

One of the printer's mechanical 
components was not properly 
registered at the expected position.

Mechanical failure or sensor 
failure.

Visually inspect the component 
stated as a reason for failure.

Using the Scan Sensors page in 
the Printer Toolbox, perform toggle 
test on sensor responsible for 
registration of failed mechanical 
component position.

Try restarting the printer.

If the problem persists, call for 
service.

System Status Source Solution
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[Crit 63 03-phead offline 
cancelpage restart]

Dirty/Damaged printhead contacts 
at the printhead or board.

Try restarting the printer.

Try replacing the printhead.

If the problem persists, call for 
service.

ONLINE

ERROR on System Status screen.

Printer Graphic shows Printer 
Service Station as “?”.

Service station position sensors 
are damaged or malfunctioning.

Check service station position.

Check for mechanical jam.

Try restarting the printer.

If the problem persists, call for 
service.

MECH_CANCELPAGE Job was canceled by the user 
pressing the Cancel Job button.

Wait until the print job has cleared 
from the printer. Then manually 
clear the job from the computer's 
print queue. Send a new print job.

PRINTHEAD_MISSINGQA

Printer Graphic shows Printer 
Printhead as “?”.

Printhead missing or printhead not 
making proper connections.

Remove the printhead, clean the 
contacts, and reinstall the 
printhead.

Replace the printhead. Refer to 
appropriate sections in this manual 
for removing and installing the 
printhead cartridge.

Try restarting the printer.

If the problem persists, call for 
service.

PRINTHEAD_UNPRIMED Printhead unprimed.

Printhead latch is open and/or the 
door is open.

Printhead priming process has 
failed.

After installing the printhead you 
must close the printhead latch and 
close all doors to start the priming 
process.

Remove the printhead cartridge, 
wet the print nozzles using distilled 
water, and reinstall printhead 
cartridge. Refer to appropriate 
sections in this manual for 
removing and installing the 
printhead cartridge. If you continue 
to have trouble priming the 
printhead, check for kinked or 
pinched ink tubes.

Try restarting the printer.

If the problem persists, call for 
service.

System Status Source Solution
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WIPER OVERTEMP Wiper motor is overheated due to 
performing a wiper transfer 
(removing excess ink off service 
station wiper) too often or for 
multiple or extended periods. The 
printer will continue maintenance 
after the wiper motor cools down. 
Message will disappear once the 
temperature returns to operating 
range.

Wait for the wiper motor to cool 
down. The printer will automatically 
resume operation.

Tip: To reduce this issue, set the 
Mid-Job Servicing interval to a 
higher number of pages.

Note: If the value is set too high, 
print quality issues may occur, 
caused by clogged or dehydrated 
nozzles.

Run Condition Wiper from the 
Touchscreen Wiper Menu. This 
rehydrates the wiper roller and 
wiper motor module which may 
help to reduce the energy it takes 
to turn the motor.

WIPER ERROR The wiper roller is not turning or is 
too hard to turn.

Possible causes:

1. Ink coagulation is making the 
motor hard to turn.

2. The wiper motor cable is 
broken or disconnected.

3. Wiper motor module failure.

1. Run Condition Wiper from the 
touchscreen Wiper Menu. This 
will rehydrate the wiper roller 
and wiper motor module.

2. Check cable and connections.

3. Replace wiper motor module.

If the problem persists, call for 
service.

System Status Source Solution
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MAINTENANCE_JAM

Note: To determine the error, 
check the touchscreen to see if it 
displays one of the following 
messages.

Sled Error - Service station sled

Lift Error - Printhead carriage lifter

Wipe Error - Wiper motor

Printhead or ink tank door opened 
during process.

Motor that drives component has 
detected a problem or movement is 
impeded.

Close doors (printhead and ink 
tank) and tap the Clear Error 
button.

Check for anything that may be 
hindering movement of item (sled, 
lifter, or wiper).

If there is a Wipe Error; run the 
Condition Wiper feature to 
rehydrate the Wiper Roller.

If there is a Sled Error or Lift Error; 
check/clean the sled and lifter 
home sensors.

If the problem persists, call for 
service.

Caution: After pressing Clear 
Error, the system will try to drive 
the sled, lifter, or wiper motor 
again. If the same error comes up 
again, after trying the above 
solutions, call for service. Pressing 
Clear Error more than a few times 
in a row may cause system 
damage.

System Status Source Solution
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Appendix A: Safety Precautions

THIS EQUIPMENT PRESENTS NO PROBLEM WHEN USED PROPERLY.

OBSERVE SAFETY RULES WHEN OPERATING THE PRINTER.

BEFORE USING PRINTER, READ THIS MANUAL CAREFULLY AND FOLLOW 
RECOMMENDED PROCEDURES, SAFETY WARNINGS, AND INSTRUCTIONS:

• Keep hands, hair, and clothing clear of rollers and other moving parts.

• Avoid touching moving parts or materials while machine is in use. Before clearing a jam, be 
sure machine mechanisms come to a stop.

• Always turn machine off before making adjustments, cleaning the machine, or performing any 
maintenance covered in this manual.

• Power cord and power supply supplied with machine. Plug it into a properly grounded, easily 
accessible wall outlet near machine. Failure to properly ground machine can result in severe 
personal injury and/or fire.

• Power cord and wall plug are primary means of disconnecting machine from power supply.

• DO NOT use an adapter plug on line cord or wall outlet.

• DO NOT remove ground pin from line cord.

• DO NOT route power cord over sharp edges or trap it between furniture.

• Avoid using wall outlets that are controlled by wall switches or shared with other equipment.

• Make sure there is no strain on power cord caused by jamming it between equipment, walls or 
furniture.

• DO NOT remove covers. Covers enclose hazardous parts that should only be accessed by a 
qualified service representative. Report any cover damage to your service representative.

• This machine requires periodic maintenance. Contact your authorized service representative 
for required service schedules.

• To prevent overheating, do not cover vent openings.

• Use this equipment only for its intended purpose.

In addition, follow any specific occupational safety and health standards for your workplace or 
area.

This manual is intended solely for the use and information of AstroNova, its designated agents, 
customers, and their employees. The information in this guide was obtained from several different 
sources that are deemed reliable by all industry standards. To the best of our knowledge, that 
information is accurate in all respects. However, neither AstroNova nor any of its agents or 
employees shall be responsible for any inaccuracies contained herein.
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Appendix B:Printer Specifications

All Specifications Subject to Change Without Notice

Printer Specifications

Print Resolution Best: 1600 x 1600 DPI

Normal: 1600 x 800 DPI

Print Speed Best: 6" (15 cm)/second

Normal: Up to 12" (30 cm)/second

Media Print Size 8.5" W x 75" L (215.9 mm x 1905 mm)

Media Types Roll or Fanfold (Label, Tag)

Media Size Minimum: 1" W x 1" L (25.4 mm x 25.4 mm)

Maximum: 9" W x 75" L (228.6 mm x 1905 mm)

Media Thickness Minimum: 3 points (0.1 mm)

Maximum: 12 points (0.3 mm)

Minimum Label Gap

(Space Between Labels)

No Bleed: 3 mm

Full Bleed: 5 mm

Media Sensing Label gap, notch, tick mark, (Continuous, blackmark, diecut)

Software Windows Printer Drivers for Windows 10 and 11.

RIP available

Diagnostics Viewable on 7" Touchscreen Display and Printer Toolbox

Data Storage Onboard Printer storage for Job Library 

Ink Water-based ink. 5 individual 250 ml ink tanks (CKMYK)

Ink Monitor Viewable on 7" Touchscreen Display and Printer Toolbox

Print Cartridge Replaceable Printhead

Interface USB 2.0 and Ethernet

Electrical 100-240 VAC, 50/60 Hz

Internal Memory Battery CR 2032 Lithium Battery

Dimensions 20.25" W x 22.25" L x 13.5" H (51.4 cm x 56.5 cm x 34.3 cm)

Weight 75 lbs. (34 kg)
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Appendix C:Borderless Printing

The printer driver (under Printing Preferences) offers two ways for printing to the edge of the 
media, sometimes called “orderless” or “full-bleed” printing. Each option adjusts the relationship 
between the target image, selected media size, and the actual media on which is it printed, but in 
different ways. Each option has advantages and disadvantages, especially for certain types of 
images.

• Borderless Print checkbox: In General Tab, under Media section.

• Oversize checkbox: In Custom Sizes dialog box, under Size section in General Tab of Print 
Preferences.

Borderless Print Checkbox
The Borderless Print Checkbox is located in the printer’s Printing Preferences, in the Media 
section under the General tab.
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Impact of Using Borderless Print
Selecting the Borderless Print checkbox scales the target image beyond the size of the selected 
media, by adding a Borderless default resolution value set in the printer driver. The image is 
stretched to print larger than actual size.

For example, if the Borderless default setting is 21 (dots), then the resultant Borderless Print 
selection will have a resolution of 821 dpi, (when printing with a normal resolution of 800). 
Although this might stretch the image beyond the edges of the media, and is quick and easy to 
select, it may be too distorted to use.

Prerequisites for Borderless Print
Since scaling can distort the image, do not use Borderless Print for targets that have barcodes or 
text because this setting could render them unreadable. If the target image is a photograph or 
other graphical image, scaling may not be noticeable or objectionable. Make test runs and check 
the effect of choosing Borderless Print.

For example, Borderless Print for a 4" x 8" label would actually be:

4" (800 dpi) + 21 dots = 3221 dots x 8" (800 dpi) + 21 dots = 6421 dots

For barcodes and text, use Oversize instead of Borderless Print.

Required preparation for Oversize is explained below.
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Oversize Settings
The Oversize checkbox is in the Custom Sizes dialog box, located in Printing Preferences under 
General tab.

Select the Oversize checkbox.

Enter measurements of the physical media in the Width and Height fields. Select units (inches or 
millimeters).

Page Setup for Oversize
When using the Oversize option, Resizing (located in the Layout tab of the driver) needs to be 
set to Original Size.
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Impact of Using Oversize
Selecting Oversize extends Custom Sizes dimensions beyond that of the actual media being 
printed on. Since this size extension is equal in both X- and Y- axes, there is no distortion of the 
target image. Instead, choosing Oversize opens more of the target image for printing, so that it 
can print beyond the size of the physical media. However, the target image also needs to be 
created as oversized, not the size of the physical media. Otherwise, there is likely to be a white 
border between the image and media.

Prerequisites for Oversize
To make Oversize an applicable option:

The target image needs to be greater in size than the size of the actual media. The image needs to 
be the same size as the custom media size selected in the Custom Sizes window, corresponding 
to the additional amount set as default in the driver.

Additional Considerations
Some additional considerations apply to both Borderless Print and Oversize in certain 
circumstances.

Minimum Label Gap and Maximum Width
For both Borderless Print and Oversize, additional consideration and testing are required when 
approaching limitations for minimum label gap and maximum label width.

• The minimum label gap is 3mm. If the media used has only a 3mm gap between labels, 
borderless printing (either Borderless Print or Oversize) may not work without skipping a 
label between printed labels. An image that goes beyond the physical media size effectively 
reduces the label gap, possibly below the 3mm minimum. This may also be beyond top of form 
(TOF) and bottom of form (BOF). If the gap is less than the minimum label gap, labels are 
skipped since TOF and BOF are undetectable for the next label.

• The maximum print width is 8.69", including physical media width + Borderless Print/
Oversize additional width. If borderless printing is required, the physical media needs to be 
narrow enough to include additional width for Borderless Print or Oversize expansion.
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Page Sizing and Handling with Adobe Acrobat
Many target images are in PDF format. When printing from Adobe Acrobat, be sure to select only 
Actual Size under Page Sizing & Handling. Other options will affect settings already made for 
Borderless Print and Oversize, producing undesirable results.
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